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Chapter 1. Overview

An introduction to the Express Runtime console

The Express Runtime console provides a single, Web-based utility for performing
administrative tasks. By providing a consistent Web-based user interface, the
Express Runtime console simplifies the experience of managing the following IBM®
Express Runtime middleware components:

 WebSphere® Application Server — Express
« DB2® UDB Express
e IBM HTTP Server

¢ Informix Dynamic Server Express

The Express Runtime console helps you to manage multiple instances of each of
the IBM Express Runtime middleware components. The IBM Express Runtime
middleware components that you manage can be on one or more computers. You
can use the Express Runtime console to perform the administrative tasks:

* Check status, start and stop application servers, Web servers, and DB2
databases.

* Configure log settings and view logs.

* Analyze logs from multiple components

 Check server status and database health.

* Perform a one-step database backup.

* Modify WebSphere Application Server — Express configuration settings.

* Filter tasks according to the role you perform.

You can access the Express Runtime console from a Web browser so you can
manage IBM Express Runtime middleware components remotely. The Express
Runtime console can be configured for use with a certificate from a certifying
authority for added security.

The Express Runtime components

The Express Runtime consists of development and deployment tools combined
with IBM middleware that you can use to create robust business solutions; the
middleware components and the Express Runtime console can be deployed as part
of your solutions. The Express Runtime console allows you to set up a system to
manage all of the middleware components. There are separate console modules for
each combination of middleware component type (application server, database, and
Web server) and target operating system.

All of these components can be deployed using the Express Runtime deployment
wizard.

The deployment of a middleware component includes a management extension,
which contains the support needed for the console to remotely manage the
facilities of that middleware component. When any management extension is
deployed to a system, the deployment wizard also installs a console agent, which
controls the communications with the console.

© Copyright IBM Corp. 2003, 2005 1



When you select any console module to deploy, the deployment wizard also
installs the Integrated Solutions Console, which provides the framework for the
console. Refer to the Integrated Solutions Console InfoCenter for more information.
The deployment wizard also installs the base Express Runtime console at that time,
including the base help topics for the console.

The Express Runtime console audience

2

InfoCenter

The Express Runtime console is intended for use by anyone who manages or
performs administrative tasks on any of the Express Runtime middleware
components. If you are a system administrator, a software developer, or a software
deployer, the Express Runtime console can help you by providing a Web-based
central location to perform many middleware management and administration
tasks, including all tasks for WebSphere Application Server — Express.



Chapter 2. Planning

Ensure that hardware and software prerequisites are met

Before you install the Express Runtime console, ensure that the hardware and
software requirements are met for the target computers to which you deploy. See
[“Hardware and software prerequisites for Express Runtime console” on page 5] By
verifying that these prerequisites are met, you can eliminate any system conflicts as
possible sources of error should you need to troubleshoot an installation.

Understand the ports that are in use on target computers

Know which ports, if any, are in use on the target computers to which you deploy.
By knowing which ports are in use, you can eliminate port conflicts. Port conflicts
are perhaps the most commonly encountered error when troubleshooting
installations. You can see which ports are used on Windows® or Linux"" by
opening a Command Prompt window on the target computer and entering the
following command:

netstat —a
To view the list of TCP ports in use on iSeries ' computers, use the netstat

command. From the menu, select option 3. Work with TCP/IP connection status to
display a list of all the ports in use.

© Copyright IBM Corp. 2003, 2005 3
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Chapter 3. Installing and configuring

Installing the console

The procedures for installing the Express Runtime console modules are specified in
this section. There are also instructions for uninstalling the console and related
modules.

Note: Applying a middleware component hotfix or fixpack not offered through the
Express Runtime product might keep the Express Runtime console from
managing the middleware component correctly. Check the Express Runtime
Support Web site or contact Express Runtime Support before you apply any
middleware hotfix or fixpack.

The instructions included only address the installation of the console modules. The
deployment and installation of the management extensions is done as part of the
deployment of the middleware components. Refer to the Express Runtime
InfoCenter for details about the installation of the middleware components.

Hardware and software prerequisites for Express Runtime
console

The Express Runtime console can be deployed from any of the system
environments supported by Express Runtime; refer to the Express Runtime
linfoCenter for details.

The following sections describe the environment for running the console.

Hardware requirements

For Linux on Intel® or Windows on Intel:

Processor
Minimum
Pentium® or equivalent 800 MHz, or equivalent
Recommended
Pentium or equivalent processor at 1.4GHz or higher, or equivalent
Memory
Minimum
1 GB (1.5 GB minimum if running all middleware and the console)
Recommended
1.5 GB (2.0 GB minimum if running all middleware and the
console)
Disk Space

* 982 MB for the installation process
* An additional 679 MB in the /tmp directory during the installation
* 290 MB for the completed installation

For Linux on Power:

© Copyright IBM Corp. 2003, 2005 5



Processor
* pSeries® models that support Linux (64-bit support only)
+ POWER4" and POWER5 "

Memory
Minimum
a 1 GB (1.5 GB minimum if running all middleware and the console)
Recommended
a 1.5 GB (2.0 GB minimum if running all middleware and the
a console)
Disk Space

* 982 MB for the installation process
* An additional 679 MB in the /tmp directory during the installation
¢ 290 MB for the completed installation

Software requirements

Operating Systems: All systems supported as targets by Express Runtime are
supported, except for iSeries.

Restriction: The console cannot be deployed to an i5/0S™" or OS/400® system.
However, these systems can be managed using the console.

a Note: The log analyzer rational agent controller for OS/400 (iSeries) requires that
a you install the IBM XML Toolkit for iSeries (5733-XT1). Contact your iSeries
a vendor to obtain a copy of the IBM XML Toolkit for iSeries.

The topic titled "Supported Web browsers” provides an exhaustive list of the Web
browsers supported by the Express Runtime console.

Supported Web browsers
The Express Runtime console supports the following Web browsers:
¢ Firefox Version 1.x
* Microsoft® Internet Explorer Version 6.0 with Service Pack 1 and later
* Mozilla Version 1.3
* Mozilla Version 1.4
* Mozilla Version 1.7

* Netscape Version 7.x

Starting the Express Runtime deployment wizard

You can deploy the Express Runtime console to one or more target computers by
using the deployment wizard. To start the deployment wizard and open the
Express Runtime console solution file:

1. On Windows, click Start > Programs > IBM Express Runtime 2.1>Deployment
Wizard. On Linux, click Main Menu > IBM Express Runtime 2.1>Start
Deployment Wizard. The deployment wizard is displayed.

2. From the deployment wizard, click File > Open.

3. By default, the contents of the Express Runtime folder is displayed. If the folder
does not open, go to folder <install_dir>\runtime21\SolutionEnabler\. Select
the appropriate file (for example., IRU2_1_1MiddlewareAll.ser). Click Open.

6 InfoCenter



4. The IBM Express Runtime Middleware panel is displayed. Click Next .

5. Select the check box (Administration) associated with the Express Runtime
console task. Click Next.

Note: You can also deploy middleware components at the same time, including
their management extensions. Click the appropriate check boxes for the
middleware components.

6. Select the check boxes associated with the platforms where you want to install.
Click Next.

Specifying target computers
Specify one or more target computers where you want to deploy the Express
Runtime console. You can select up to 100 target computers. To specify a target
computer, you must specify the fully qualified domain name or the IP address of
that computer. A fully qualified domain name includes all higher level domain
names, up to the top-level domain name.

Use the following guidelines to ensure the correct format of a domain name:

* An alphanumeric text string up to 24 characters in length, containing any of the
letters A - Z, digits from 0 - 9, the minus sign (-), and period (.)

* The first character must be an alphabetical.

* You can use upper and lowercase letters.

* The last character cannot be a minus sign or a period.

* Only use periods to delimit components of a domain name.
* Do not use blank or space characters.

Use the following guidelines to ensure the correct format for an IP Address:
* A 32-bit numeric address written containing four numbers.
* Each of these four numbers can range from 0 to 255.

* Each of the four numbers is separated by periods.

To specify a target computer:

1. In the Target computer field, type the fully qualified domain name, or the IP
address of the target computer. Each time a domain name or IP address is
entered, the format is checked to ensure the entry is valid. In addition to
verifying the correct format, a check is made for duplicate entries.

2. Click Add.
Repeat steps one and two for all additional target computers.

w

4. Click Test Connections to verify the deployment wizard can connect to the
specified target computers. The Target Computer Data window opens and
displays the status for each target computer. If the deployment wizard cannot
connect to a target computer, verify that the fully qualified domain name or IP
address is correct. If this information is correct, contact the computer owner to
determine whether the target computer is running and connected to a network.
Click OK to close the window.

Important: Ensure that the IBM Installation Agent exists on all the target
computers for a deployment. You do not need to install the IBM
Installation Agent on the computer called Tocalhost if it is the
target of a deployment.

5. Click Next.

Chapter 3. Installing and configuring 7
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Providing configuration parameters

The Deployment Parameters dialog contains the deployment parameters for an
application that is associated with a selected task. Deployment parameters are used
to configure an installation during deployment. Examples of deployment
parameters include user IDs, passwords, and target directories.

In many cases, the deployment parameters can have default values. You can use or
modify the default values. The values are shared with all target computers that are
associated with a task.

Complete all the required fields on the deployment parameters dialog. Required
fields are denoted on the dialog with an asterisk.

Provide the following deployment parameters:

*Installation location
Provide the location of the directory where the Express Runtime console is
to be installed on the target computers. Provide a full path to the
installation location.

*HTTP Port
Provide the port number that is used for HTTP activity on the target
computer. This is used when logging in to the console.

*Bootstrap/RMI Port
Provide the port number that is used for Bootstrap and Remote Method
Invocation (RMI) activity on the target computer.

*HTTPS Port
Provide the port number that is used for HTTPS activity on the target
computer.

*SOAP Port
Provide the port number that is used for Simple Object Access Protocol
(SOAP) activity on the target computer.

*Application Server HTTP Port
Provide the port number that is used for the application server HTTP
activity on the target computer. This is used when logging in to the
console.

*Application Server Bootstrap/RMI Port
Provide the port number that is used for the application server Bootstrap
and Remote Method Invocation (RMI) activity on the target computer.

*Application Server HTTPS Port
Provide the port number that is used for the application server HTTPS
activity on the target computer.

*Application Server SOAP Port
Provide the port number that is used for the application server Simple
Object Access Protocol (SOAP) activity on the target computer.

*Eclipse Port
Provide the port number that is used for the Eclipse server on the target
computer.

Administrator ID
Provide the ID of the administrator for the Express Runtime console. This
is used when logging in to the console.
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Password
Provide a password that is associated with the administrator ID. This is
used when logging in to the console.

Verify password
Reenter the password that is associated with the administrator ID to verify
it.

Console module for WebSphere Application Server - Express
Select Yes if you want to deploy the console plug-in for WebSphere
Application Server - Express. If your solutions do not use WebSphere
Application Server - Express, or you already have it installed on the target
computer, you do not need to deploy this console plug-in.

Console module for a database
Select Yes if you want to deploy the console plug-in for databases. If your
solutions do not use DB2 UDB Express or Informix Dynamic Server
Express, or you already have installed the database component on the
target computer, you do not need to deploy this console plug-in.

Console module for IBM HTTP Server
Select Yes if you want to deploy the console plug-in for IBM HTTP Server.
If your solutions do not use IBM HTTP Server, or you already have it
installed on the target computer, you do not need to deploy this console
plug-in.

When you have specified the configuration parameters on the dialog, verify there
are no port conflicts. You can verify that there are no port conflicts by opening a
command prompt window on the target computer and entering the following
command:

netstat —a

Examine the list to ensure that there will be no port conflicts. If there are any ports
in use which conflict with those you specified, provide different port values in the
configuration parameters. When you finish entering the configuration parameters,

click Next.

Deploying the Express Runtime console

The deployment wizard displays a summary dialog of the Express Runtime
console task and the target computers selected for deployment. An estimate of the
time to install the Express Runtime console task is provided, along with the
summary of the task. Click Deploy all to deploy the Express Runtime console task.

The deployment wizard provides information about the status of deployment for
the Express Runtime console task. It displays the percent complete for a task as it
is deployed, and an estimate of the time remaining until deployment has
completed. If a task is successfully deployed, a green check mark is displayed next
to the task. If a task failed to deploy, a red X is displayed next to the task. If a task
is not successfully deployed, one or more messages are displayed to help identify
the reason the deployment was not successful. Click Detailed messages to see a
list.

For more information regarding status messages and logging options, refer to the
Express Runtime Information Center.

Chapter 3. Installing and configuring 9
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Verifying a successful installation

When you have deployed the Express Runtime console to a target computer, you

can verify the installation by performing the following steps:

1. Point a Web browser to the following URL: http://host
name :8421/ibm/console where host name is the value that you provided for the
Host Name configuration parameter in the deployment wizard, and 8421 is the
value that you provided for the HTTP Port configuration parameter in the
deployment wizard.

2. When the Express Runtime console login page is displayed, enter the
Administrator ID configuration parameter that you provided in the deployment
wizard into the User ID field.

3. Enter the password that you provided in the deployment wizard into the
Password field.

4. Click Log in.

Verify that the Console for Express Runtime is shown on the Welcome page.

Using a certificate from a certifying authority

InfoCenter

For added security, you can use a certificate from a certifying authority. Certificates
are based on public and private key technology. Each key is like a unique
encryption device. No two keys are ever identical, which is why a key can be used
to identify its owner. Keys always work in pairs, one called the private key, and
the other called the public key. What a public key encrypts, only the corresponding
private key can decrypt, and vice versa. Public keys are distributed freely to
anyone who wants to exchange secure information with you. The private key is
never copied or distributed and remains secure on your computer or server.

You can set up a certificate on the computer which runs the console; you can also
set up a certificate on any computer where the console agent is installed (that is,
where a middleware components is installed). The procedures for doing this must
be performed at the specific computer to be configured. To use a certificate from a
certifying authority, you perform the following tasks (specific instructions in
separate topics give details for the console computer and for the computer with the
console agent):

1. Create a certificate-signing request.
2. Receive a certificate that has been signed by a certifying authority.

3. Remove the default self-signed certificate from the Express Runtime console or
console agent keystore.

4. Restart the Express Runtime console or console agent.

These tasks are applicable to:
* Windows or Linux computers on which the console is installed

* Windows or Linux or iSeries computers on which the management extensions
are installed

Certificate for console

Create a certificate-signing request: To obtain a certificate from a certificate
authority, submit a certificate-signing request using the key management utility
iKeyman. With the key management utility, generating a certificate-signing request
also generates a private key for the application for which the certificate is
requested. The private key remains in the application keystore file, so it stays
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private. The public key is included in the certificate requested. To create a
certificate-signing request, perform the following steps:

1.

8.

Start the key management utility by opening a Command Prompt window. Go
to the <iia_installation>/java/jre/bin directory, where iia_installation is the
directory in which the console is installed. Enter the command ./ikeyman.exe
on Windows computers, or iKeyman on Linux computers.

From the iKeyman dialog, click Key Database File > Open. Select JKS for the
Key database type. Select cacert for the filename. For location, select
C:\Program
Files\IBM\ConsoleIR21\AppServer\java\jre\lib\security\cacert on
Windows computers, or
/lopt/IBM/ConsoleIR21/AppServer/javal/jre/lib/security/cacert on Linux
computers. Click OK.

Type the password and click OK. By default the password is changeit.

Click Create > New Certificate Request. The Create New Key and Certificate
Request dialog is displayed.

Specify a value for the Key Label, Common Name, and Organization fields,
and then select a country.

* For Key Label, enter a label that identifies the certificate. For example,
Certificate for Express Runtime console.

¢ For Common Name, enter the fully qualified host name of the server that is
hosting the Express Runtime console. For example, myserver.mydomain.com

* For Organization enter the official name of the company. For example,
MyCompany, Inc.

* For the remaining fields, accept the default value or, optionally, provide
information.

* Type a name for the file that contains the certificate request. For example,
certreq.arm

Click OK. A new file that corresponds with the name you provided in step El is
created.

Send the file to the certificate authority following the instructions for requesting
a new certificate. Instructions for requesting a new certificate can be found on
the Web site for the certificate authority that you are working with.

Close the iKeyman utility.

Receiving certificate-authority signed certificates: When a certificate-signing
request is accepted, a certificate authority processes the request and verifies your
identity. When approved, the certificate authority sends the signed certificate back
through e-mail. Store the signed certificate in a keystore database file.

To receive the certificate authority signed certificate into a keystore file using the
iKeyman utility, perform the following steps:

1.

Start the key management utility by opening a Command Prompt window. Go
to the <iia_installation>/java/jre/bin directory, where iia_installation is the
directory in which the console is installed. Enter the command ./ikeyman.exe
on Windows computers, or iKeyman on Linux computers.

From the iKeyman dialog, click Key Database File > Open. Select JKS for the
Key database type. Select cacert for the filename. For location, select
C:\Program

Files\IBM\ ConsoleIR21\ AppServer\java\jre\lib\security \cacert on

Chapter 3. Installing and configuring 11
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Windows computers, or
/opt/IBM/ConsoleIR21/AppServer/javal/jre/lib/security/cacert on Linux
computers. Click OK.

Type the password and click OK. By default the password is changeit.
Select Personal Certificates from the list.

Click Receive.

Click Data type and select the data type of the new digital certificate, for
example, Base64-encoded ASCII data. Select the data type that matches the
certificate-authority signed certificate. If the certificate authority sends the

certificate as part of an e-mail message, you can cut and paste the certificate
into a separate file.

ook~ w

7. Type the certificate file name and location for the new digital certificate, or click
Browse to locate the certificate authority signed certificate.

8. Click OK.
9. Type a label for the new digital certificate and click OK.

Remove the default certificate from the keystore: When you add the
certificate-authority signed certificate to the keystore, remove the default
self-signed certificate.

To remove the self-signed certificate from the keystore file using the iKeyman
utility, perform the following steps:

1. Start the key management utility by opening a Command Prompt window. Go
to the <iia_installation>/java/jre/bin directory, where iia_installation is the
directory in which the console is installed. Enter the command ./ikeyman.exe
on Windows computers, or iKeyman on Linux computers.

2. From the iKeyman dialog, click Key Database File > Open. Select JKS for the
Key database type. Select cacert for the filename. For location, select
C:\Program

Files\IBM\ConsoleIR21\ AppServer\java\jre\lib\security \cacert on
Windows computers, or
/lopt/IBM/ConsoleIR21/AppServer/javal/jre/lib/security/cacert on Linux
computers. Click OK.

Type the password and click OK. By default the password is changeit.

Select Personal Certificates from the list.

Select the certificate labeled IRU_Cert.

Click Delete. A confirmation dialog is displayed. Click Yes.

N o s~

Close the iKeyman utility.

Restarting the Express Runtime console: When all of the key management tasks
have been completed, the Express Runtime console must be restarted to use the
new certificate-authority signed certificate.

To restart the Express Runtime console on Windows computers:

To start Integrated Solutions Console:
C:\Program Files\IBM\ConsoleIR21\PortalServer\bin\startISC.bat
<userlD> <password>, where <userID> and <password> are those assigned
during the installation of the console.

To stop Integrated Solutions Console:
C:\Program Files\IBM\ConsoleIR21\PortalServer\bin\stopISC.bat
<userID> <password>, where <userID> and <password> are those assigned
during the installation of the console.
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Alternatively, on Windows computers, you can use the Services panel to start or
stop the Integrated Solutions Console. The service name is IBM WebSphere
Application Server V5 - ISC_Portal.

On Linux systems, use the following shell scripts:

To start Integrated Solutions Console:
C:\Program Files\IBM\ConsoleIR21\PortalServer\bin\startISC.sh
<userID> <password>, where <userID> and <password> are those assigned
during the installation of the console.

To stop Integrated Solutions Console:
C:\Program Files\IBM\ConsoleIR21\PortalServer\bin\stopISC.sh
<userID> <password>, where <userID> and <password> are those assigned
during the installation of the console.

Certificate for console agent

Create a certificate-signing request: To obtain a certificate from a certificate
authority, submit a certificate-signing request using the key management utility
iKeyman. With the key management utility, generating a certificate-signing request
also generates a private key for the application for which the certificate is
requested. The private key remains in the application keystore file, so it stays
private. The public key is included in the certificate requested. To create a
certificate-signing request, perform the following steps:

1. Start the key management utility by opening a Command Prompt window. Go
to the <console_agent_installation>/java/jre/bin directory, where
console_agent_installation is the directory in which the console agent is installed.
Enter the command ./ikeyman.exe on Windows computers, or iKeyman on
Linux computers.

2. From the iKeyman dialog, click Key Database File > Open. Select JKS for the
Key database type. Select iru_certificates_ext.jks for the filename. For location,
select C:\Program Files\IBM\IRUExt\ConsoleAgent\iru_certificates_ext.jks
on Windows computers, or
{opt/IBM/IRUExt/ConsoleAgent/iru_certificates_ext.jks on Linux computers, or
/QIBM/ProdData/IRUExt/ConsoleAgent/iru_certificates_ext.jks on iSeries.
Click OK.

3. Type the password and click OK. By default the password is changeit.

Restriction: Do not change this password; otherwise the console agent will not
function.

4. Click Create > New Certificate Request. The Create New Key and Certificate
Request dialog is displayed.

5. Specify a value for the Key Label, Common Name, and Organization fields,
and then select a country.

* For Key Label, enter a label that identifies the certificate. For example,
Certificate for Express Runtime console.

¢ For Common Name, enter the fully qualified host name of the server that is
hosting the Express Runtime console. For example, myserver.mydomain.com

* For Organization enter the official name of the company. For example,
MyCompany, Inc.

* For the remaining fields, accept the default value or, optionally, provide
information.

* Type a name for the file that contains the certificate request. For example,
certreq.arm

Chapter 3. Installing and configuring 13
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6. Click OK. A new file that corresponds with the name you provided in step El

is created.

7. Send the file to the certificate authority following the instructions for requesting
a new certificate. Instructions for requesting a new certificate can be found on
the Web site for the certificate authority that you are working with.

8. Close the iKeyman utility.

Receiving certificate-authority signed certificates: When a certificate-signing
request is accepted, a certificate authority processes the request and verifies your
identity. When approved, the certificate authority sends the signed certificate back
through e-mail. Store the signed certificate in a keystore database file.

To receive the certificate authority signed certificate into a keystore file using the
iKeyman utility, perform the following steps:

1. Start the key management utility by opening a Command Prompt window. Go
to the <console_agent_installation>/java/jre/bin directory, where
console_agent_installation is the directory in which the console agent is installed.
Enter the command ./ikeyman.exe on Windows computers, or iKeyman on
Linux computers.

2. From the iKeyman dialog, click Key Database File > Open. Select JKS for the
Key database type. Select iru_certificates_ext.jks for the filename. For location,
select C:\Program Files\IBM\IRUExt\ConsoleAgent\iru_certificates_ext.jks
on Windows computers, or
/opt/IBM/IRUExt/ConsoleAgent/iru_certificates_ext.jks on Linux computers, or
/QIBM/ProdData/IRUExt/ConsoleAgent/iru_certificates_ext.jks on iSeries.
Click OK.

3. Type the password and click OK. By default the password is changeit.

Restriction: Do not change this password; otherwise the console agent will not
function.

4. Select Personal Certificates from the list.
5. Click Receive.

6. Click Data type and select the data type of the new digital certificate, for
example, Base64-encoded ASCII data. Select the data type that matches the
certificate-authority signed certificate. If the certificate authority sends the
certificate as part of an e-mail message, you can cut and paste the certificate
into a separate file.

7. Type the certificate file name and location for the new digital certificate, or click
Browse to locate the certificate authority signed certificate.

8. Click OK.
9. Type a label for the new digital certificate and click OK.

Remove the default certificate from the keystore: When you add the
certificate-authority signed certificate to the keystore, remove the default
self-signed certificate.

To remove the self-signed certificate from the keystore file using the iKeyman
utility, perform the following steps:

1. Start the key management utility by opening a Command Prompt window. Go
to the <console_agent_installation>/java/jre/bin directory, where
console_agent_installation is the directory in which the console agent is installed.
Enter the command ./ikeyman.exe on Windows computers, or iKeyman on
Linux computers.
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From the iKeyman dialog, click Key Database File > Open. Select JKS for the
Key database type. Select iru_certificates_ext.jks for the filename. For location,
select C:\Program Files\IBM\IRUExt\ConsoleAgent\iru_certificates_ext.jks
on Windows computers, or
{opt/IBM/IRUExt/ConsoleAgent/iru_certificates_ext.jks on Linux computers, or
/QIBM/ProdData/IRUExt/ConsoleAgent/iru_certificates_ext.jks on iSeries.
Click OK.

Type the password and click OK. By default the password is changeit.

Restriction: Do not change this password; otherwise the console agent will not
function.

Select Personal Certificates from the list.

Select the certificate labeled IRU_Cert.

Click Delete. A confirmation dialog is displayed. Click Yes.
Close the iKeyman utility.

Restarting the Express Runtime console agent: When all of the key management
tasks have been completed, the Express Runtime console agent must be restarted
to use the new certificate-authority signed certificate.

To restart the Express Runtime console agent on Windows computers:

. Click Start > Settings > Control Panel.
. Double-click Administrative Tools.

1
2
3. Double-click Services.
4.
5
6

Select Express Runtime console Agent.

. Click Restart.

. Close the Windows Services panel.

To restart the Express Runtime console agent on iSeries computers:

. Open a terminal window.

Launch QSH.

1
2
3. Change directories to /QIBM/ProdData/IRUExt/ConsoleAgent
4.
5
6

Run IRU_ConsoleAgent_Stop.

. Run IRU_ConsoleAgent_Start.
. Close the terminal window.

Troubleshooting the installation results

If the installation of the Express Runtime console fails, ensure that:

No previous installations of Integrated Solutions Console, or unsuccessful
uninstallations of Integrated Solutions Console exist on the target computer.

The system PATH environment variable is not too long. If the PATH
environment variable is too long, attempt to change it to something shorter until
the installation completes.

Port conflicts do no occur when the target computer or applications running on
the target computer are using the default WebSphere Application Server —
Express or IBM HTTP Server ports, or if the ports configured for use with the
Express Runtime console. Port conflicts can occur when the installation
reconfigures ports that were used prior to installation of the Express Runtime
console. To resolve port conflicts, stop WebSphere Application Server — Express
or Web servers until the installation completes.

Chapter 3. Installing and configuring 15
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* The target computer host name is fully qualified. If you see a log message
indicating that it is not, refer to the documentation for the target computer
operating system for instructions on changing the system configuration to give
the system a fully qualified host name.

Upgrades to the console require that the Integrated Solutions Console be stopped
and restarted. This operation can take a significant amount of time (approximately
fifteen minutes). During that time, there is no response or status display to indicate
this process is underway. Be sure to allow sufficient time for the console to restart.

Log files are useful in troubleshooting installation and uninstallation problems. You
can find the installation and uninstallation log files for the Integrated Solutions
Console in the directory defined by the value of the $TEMP or %TEMP% or %TMP% or
environment variable on the computer where the Express Runtime console is
installed.

The deployment wizard log file should also be examined; its default location in
Windows is C:\Program
Files\IBM\SolutionEnabler\logs\IRU_DeploymentWizard.log.

Note: Applying a middleware component hotfix or fixpack not offered through the
Express Runtime product might keep the Express Runtime console from
managing the middleware component correctly. Check the Express Runtime
Support Web site or contact Express Runtime Support before you apply any
middleware hotfix or fixpack.

Problems with Integrated Solutions Console

If there is a problem with the installation of the console and the log message
indicates a return code from the Integrated Solution Console, check the return
code. These return codes, and their meanings, are summarized in the following
table. If you get a return code of 104, verify that you have the user ID and
password specified correctly, and restart the task. For all other return codes,
contact your IBM Support Center representative.

ISCDeploy (INSTALL) return codes:

Return code Explanation and recommended action
0 The Integrated Solutions Console component was replaced successfully.
1 A syntax error occurred.
2 The specified WAR file was not found. Specify the correct file path and
filename.
3 The protocol or the context URL that you specified is not correct. Verify

that the URL includes the correct protocol (http:// or https:/ /). Specify
deploy/deploy as the context URL.

4 The host name you specified is not valid or the Integrated Solutions
Console server is not running. Verify that the URL includes the correct
host name. Start the server before you issue the deploy command.

10 The correct parameters were not specified.
70 The replacement process completed successfully.
71 The replacement process did not complete successfully. This message

usually indicates a problem with a portlet in the component WAR file. See
the log file wps_date_time.log for messages that were logged before this
return code was displayed. Use the time stamps in the file to locate those
messages.




O e D D

o o e

[

o=V

[ I -V VR )

oo oo

Return code

Explanation and recommended action

81

An error occurred while deploying the help files for the component. The
attempt to copy the help files to the system has failed.

100

This component cannot be deployed, because it has been deployed
already. If you want to deploy the component again, you can use
IscReplace to update the component.

101

This component cannot be deployed, because it has a prerequisite
component and the prerequisite has not been deployed. Deploy the
prerequisite component and then deploy this component.

102

This component has a prerequisite component, but the wrong version of
the prerequisite is deployed. Deploy the correct version of the prerequisite
component and then deploy this component.

104

The Integrated Solutions Console administrator user ID, password, or both
are not correct. Specify the correct values.

105

An internal error has occurred. A server-side file was not found. Be sure
to specify the fully-qualified or relative file path and the WAR filename.
Contact your service representative if the problem persists.

106

The component.xml file in the WAR file is not valid. Correct the file and
repackage the WAR file.

108

An internal error has occurred. Contact your service representative.

ISCRemove (UNINSTALL) return codes:

Return code

Explanation and recommended action

The Integrated Solutions Console component was replaced successfully.

A syntax error occurred.

The protocol or the context URL that you specified is not correct. Verify
that the URL includes the correct protocol (http:// or https://). Specify
deploy/deploy as the context URL.

The host name you specified is not valid or the Integrated Solutions
Console server is not running. Verify that the URL includes the correct
host name. Start the server before you issue the deploy command.

84

An error occurred while removing the help plug-ins for this component.
No action is required.

200

The component cannot be replaced, because a component with the same
component UID is not already deployed. Specify a WAR file for a
component that is already deployed or use IscDeploy to deploy this
component for the first time.

201

This component cannot be removed, because it is a prerequisite
component for one or more components. Remove the dependent
components before you remove this component.

Uninstallation

This section addresses the procedure for uninstalling the Express Runtime console.

Uninstalling the Express Runtime console

To uninstall Express Runtime console from a Windows computer, follow these

steps:

1. Select Control Panel > Add or Remove Programs.

Chapter 3. Installing and configuring 17
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2. Select IBM Express Runtime Console from the Add or Remove Programs
dialog.

3. Click Change/Remove.
4. The uninstallation welcome screen appears. Click Next.
5. Verify or change the list of console modules that are marked for uninstallation.

Click Next.
6. Click Finish to close the uninstallation program.

To uninstall Express Runtime console from a Linux computer, follow these steps:

1. Invoke the uninstall program located in <installation
directory>/IBM/ConsoleIR21/ConsoleUninst.

2. The uninstallation welcome screen appears. Click Next.

3. Verify or change the list of console modules that are marked for uninstallation.
Click Next.

4. Click Finish to close the uninstallation program.

Tip: Some folders and files might not be automatically removed when the Express
Runtime console is uninstalled. This is the case when the files are in use at
the time the uninstallation is performed.

You can delete these folders and files manually.

If an installation of the Integrated Solutions Console fails, you can manually
uninstall the Express Runtime console. To manually uninstall the Express Runtime
console, perform the following steps:

1. Navigate to the system temporary directory. The temporary directory is the
value of the operating system variable $TEMP or %TEMP% or %TMP%.

2. Save a copy of the following files:
* ISCRuntimelnstall.log
* ISCRuntime.rsp
¢ ISCRuntimeUninstall.log
 All Portal*.log files

3. In the temporary directory, delete all of the files and the directories that begin
with the string ISC, such as ISCRuntime.rsp, ISC_TEMP, ISCToolkitInstall.log,
Portallnit.log, and PortalSetupWAS.log.

4. Locate the file vpd.properties in the file system by using Start > Search > For
Files in Windows, or Main Menu > Search in Linux.

5. Save a copy of the vpd.properties file.

6. Open the vpd.properties file in an ASCII text editor. Delete each line that

contains the string isc_root where isc_root is the root directory of the console
installation.

7. Delete the isc_root directory. If you cannot delete the isc_root directory, ensure
that all Java'" processes have been stopped, and attempt to delete the directory
again.

Uninstalling the management extensions

InfoCenter

The management extensions are not uninstalled when the Express Runtime console
is uninstalled. You must uninstall them separately.

Note: The console agent is uninstalled as part of the process.



Uninstall the management extensions on the system with the middleware
component, as follows:

Management extension for DB2 UDB Express for Windows

Follow these steps:
1. Select Control Panel > Add or Remove Programs.

2. Select IBM Express Runtime Management Extension, Version 2.1.1 for IBM
DB2 Universal Database Express from the Add or Remove Programs dialog.

3. Click Change/Remove.
4. Follow the prompts in the uninstallation program.

Management extension for DB2 UDB Express for Linux

An uninstallation executable file is provided in the
<install_base>/IRUExt/DB2/instancel/_uninst folder, where instancel is the
location of the first instance of DB2 UDB Express (you may choose any other
instance). This file starts an interactive uninstallation.

Management extension for DB2 UDB Express for i5/0S (0S/400 )

DB2 is an integral part of the database function imbedded in the i5/0S (OS/400)
operating system. It cannot be uninstalled.

Management extension for IBM HTTP Server for Windows and
Linux

For Windows, follow these steps:
1. Select Control Panel > Add or Remove Programs.

2. Select IBM Express Runtime Management Extension, Version 2.1.1 for IBM
HTTP Server from the Add or Remove Programs dialog.

3. Click Change/Remove.
4. Follow the prompts in the uninstallation program.

For both Linux and Windows, an uninstallation executable file is provided in the
<install_base>/IRUExt/IHS/instancel/_uninst folder. This file starts an interactive
uninstallation.

Management extension for WebSphere Application Server -
Express for Windows and Linux

For Windows, follow these steps:
1. Select Control Panel > Add or Remove Programs.

2. Select IBM Express Runtime Management Extension, Version 2.1.1 for IBM
WebSphere Application Server Express from the Add or Remove Programs
dialog.

3. Click Change/Remove.

4. Follow the prompts in the uninstallation program.

For both Linux and Windows, an uninstallation executable file is provided in the
<install_base>/IRUExt/WAS/instancel/_uninst folder, where instancel is the
location of the first instance of WebSphere Application Server — Express (you may
choose any other instance). This file starts an interactive uninstallation.

Chapter 3. Installing and configuring 19
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Management extension for i5/0S (0S/400)

To uninstall the management extension for i5/0S, run the following command:

/QIBM/ProdData/IRUExt/IRU_ManagementExtensions_Uninstall.

Management extension for IBM Informix® Dynamic Server
Express for Windows and Linux

For Windows, follow these steps:

1.
2.

3.
4.

Select Control Panel > Add or Remove Programs.

Select IBM Express Runtime Management Extension, Version 2.1.1 for
Informix Dynamic Server from the Add or Remove Programs dialog.

Click Change/Remove.
Follow the prompts in the uninstallation program.

For both Linux and Windows, an uninstallation executable file is provided in the
<install base>/IRUExt/IDS/instancel/_uninst folder. This file starts an interactive
uninstallation.
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Chapter 4. Using the console

Using the console

This section provides guidance on using console functions to administer servers.
There are procedures for all of the console functions and each management
extension.

Help files that are linked from the portlets are also included in this section; see
[“Express Runtime console help topics” on page 38/ You might not find the help
files for a console module that is not installed.

Starting and setting up the console

The topics in this section describe how to use the console to administer the
middleware components you have installed. You should have installed the
management extensions for the components you want to manage. You should also
have defined any user IDs and passwords needed for managing those extensions.

Starting and stopping Integrated Solutions Console

When an installation is successful, the Integrated Solutions Console starts
automatically. If you need to stop or start the Integrated Solutions Console
manually to resolve a problem, you can use the following batch files on Windows
systems:

To start Integrated Solutions Console:
C:\Program Files\IBM\IRConsole\PortalServer\bin\startISC.bat <userID>
<password>, where <userID> and <password> are those assigned during the
installation of the console.

To stop Integrated Solutions Console:
C:\Program Files\IBM\IRConsole\PortalServer\bin\stopISC.bat <userID>
<password>, where <userID> and <password> are those assigned during the
installation of the console.

Alternatively, on Windows computers, you can use the Services panel to start or
stop the Integrated Solutions Console. The service name is IBM WebSphere
Application Server V5 - ISC_Portal.

On Linux systems, use the following shell scripts:

To start Integrated Solutions Console:
C:\Program Files\IBM\IRConsole\PortalServer\bin\startISC.sh <userID>
<password>, where <userID> and <password> are those assigned during the
installation of the console.

To stop Integrated Solutions Console:
C:\Program Files\IBM\IRConsole\PortalServer\bin\stopISC.sh <userID>
<password>, where <userID> and <password> are those assigned during the
installation of the console.

Connecting to the Integrated Solutions Console

To connect to the Integrated Solutions Console, open a Web browser and point to
the following URL:

© Copyright IBM Corp. 2003, 2005 21
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http://host name:8421/ibm/console/

Where host name is the fully-qualified host name of the server where Integrated
Solutions Console is installed, and 8421 is the default HTTP port for Integrated
Solutions Console.

Logging in to the Integrated Solutions Console

Enter the User ID and Password that were defined when installing the console.
Click Login. The Welcome panel is displayed, and the navigation frame is shown
on the left. Refer to the Integrated Solutions Console InfoCenter for a description
of the layout of the console panels and basic instruction on the use of the console.
You can access the InfoCenter by clicking the Help link at the top right of the
panel. The help system is displayed. Click Console Basics in the navigation frame
on the left to display the Integrated Solutions Console InfoCenter. The InfoCenter
for the Express Runtime console is also accessible from the navigation frame.

Using the navigation frame

The console displays a navigation frame on the left side of the window. The
navigation frame has tabs at the top, and organizes tasks into Work Items, Status,
and Settings groups. Select the Work Items tab for viewing the console tasks.

Within a tabbed set of tasks, you can select folders to open by clicking the D

icon; this opens the folder (E?) and exposes its content. There can be multiple
levels of folders. Tasks are listed under the folders; some tasks are further

subdivided, and can be shown by clicking the icon. This opens the contents;

the list can be closed by clicking the resulting IE' icon.

The navigation tree can contain selections for any number of products. The
following example is organized in the same way as the navigation frame and
shows a representative sample of installed modules, including those for the
Express Runtime console. The selections for the Express Runtime console are
shown with the tree nodes expanded to expose all the linkable elements; each
linkable selection takes you to the help text for the corresponding portlet (in a
similar manner as the actual navigation frame links to the portlet). In addition,
there are separate links shown to take you to the applicable procedural description:

Welcome

Ei' First steps (See |“Getting started with the console” on page 25.
"“Getting started with the console” on page 2

Configure Express Runtime console|

Ei' Monitoring and tuning (See [“Monitoring components” on page 28.)
All application servers|

All databases]

All Web servers|

Custom solutions|

Application servers

Ei' Troubleshooting



IE' Console agent (See [“Troubleshooting console agents” on page 29.)

[Logs and trace]

IE' Application servers (See [“Viewing information on an application|
lserver” on page 35.)

E Configuration problems

[Configuration problems|

IE' Web servers
[Logs and trace| (See ["Modifying log settings” on page 37.)

Ei' Servers

IE' Application servers (See [“Viewing information on an application|
lserver” on page 35 for all except status.)
Status - application server| (See ["Managing an application server” on page 34))
Application server settings|

Update Web server plug-ins|

IE' Web servers
“Status - Web server” on page 59| (See ["Managing a Web server”]

on page 36.|)

D Applications

D Resources

D Security

D Environment

r_—l System administration
D Service integration

D UDDI references
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E Databases

Status - database| (See ["Managing a database” on page 30)
Backup| (See [‘Backing up a database” on page 31.)

Alerts (See [‘Viewing the alerts for a database” on page 32))

E Manage System Health
(See [“Viewing the health of all managed databases” on page 33.)

Obtaining help

To obtain general console help, click the Help link in the upper right corner of the
console window. This displays a separate window containing the information
centers for the Integrated Solutions Console (shown as Console Basics) and any
other console modules deployed, such as the Express Runtime console. You can
use them to learn about the general functions and operation of the console.

To obtain help for a specific portlet, click the Ed icon in the upper right corner of
the portlet title bar. These help files are also part of this information center for the
Express Runtime console.

Tip: You can also display help files for the WebSphere Application Server —
Express product; these are accessed from links contained in the windows
displaying WebSphere Application Server — Express server outputs (see
[“Viewing and modifying server settings” on page 35).

Viewing tables
Many of the tasks use tables to present the list of items to be worked with; these
tables have facilities to simplify your access to the items.

To assist you in managing a large number of items, you can filter and sort the table
rows using the table icons.

Using filtering to view tables

To filter the table:

¥
1. Click the Show Filter Row icon ( ) in the table action bar. This displays
a filter row at the top of the table.

2. To apply a filter to a column, click the Filter link in the filter row below the
column header.

3. Enter the condition you want to apply to the column.
4. Click OK.

Tip: The filter can be removed by deselecting the box in the filter row.
Using sorting to view tables

To sort the table:

1. Click the Edit Sorts icon () in the table action bar. A sort dialog is

displayed.
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2. Select up to three columns to sort on, for each selected column. Choose
whether the sort should be Ascending or Descending.

3. Click OK.

Tip: To sort by just one column, you can use the ™ icon in the column header
bar instead of using the sort dialog. Clicking the resulting icons alternates

between ascending (indicated by ~ ) and descending (indicated by b i )

sorts of the list. Click the Clear All Sorts icon () to deactivate

sorting.

Getting started with the console
Use this task if this is your first time using the console. It provides abbreviated
descriptions and instructions for the basic tasks you can perform with the console.

Configuring Express Runtime console

Use the Configure Express Runtime console task to locate middleware components
on hosts that you can configure into the Express Runtime console. You can also
configure predefined custom solutions from designated hosts into the console.
Using the Configure Express Runtime console task saves you time because it
ensures that you provide all of the necessary information to connect to the
component, and thereby eliminates the possibility of forgetting to provide any
required information.

Note: Whenever any component that has been previously configured into the
console is updated, you must use this task to update the configuration
information in the console. When you install a new version of the console,
you must use this task to reconfigure all of the components and custom
solutions.

The Configure Express Runtime console task contacts a console agent located on
the host and determines whether or not the host has any components that are
registered. The agent authenticates with the host using a local operating system
User ID and password. In specific cases, other information is required for
authentication.

Note: Custom solutions can be predefined on the specified hosts, using an XML
file to specify the components in the solution. (See [‘Defining custom|
[solutions using XML files” on page 69 for information about this XML file.)
If you have components on hosts that were not predefined as part of a
custom solution, you can set them up using the custom solutions function of
the console.

You can launch the Configure Express Runtime console task in the following ways:
¢ From the Getting started with the Express Runtime console panel
* From the navigation tree in the Express Runtime console

* From links provided on the Add/Remove panels for managing the individual
components

* From links provided on the context selection panels for managing the individual
components
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The specific steps and panels used to configure the console are described in the
help for this feature; see [‘Configure Express Runtime console” on page 41| for
details.

Using custom solutions

InfoCenter

A custom solution is a collection of components, such as application servers, Web
servers, and databases. You can monitor a custom solution for the operational state
and alert status of all its components. A custom solution is designed to monitor,
start, and stop a set of components having something in common. A typical
solution is one consisting of the components required to host a particular
application. You can add, edit, or remove custom solutions at any time. You can
also analyze log files for all or some of the components in a custom solution.

Three special custom solutions are predefined and cannot be edited or removed:
 All application servers

* All Web servers

* All databases

You can launch the predefined custom solutions by opening the Monitoring and
tuning folder and selecting the appropriate task (for example, All databases).

Defining custom solutions

Custom solutions can best be defined by creating XML files for this purpose. See
[“Defining custom solutions using XML files” on page 69 for details. If your custom
solutions are predefined, you should use the configure custom solutions facility
(see [“Configuring Express Runtime console” on page 25)) to have them configured
into the console.

If you do not have your custom solutions predefined, or your middleware
component installation does not support predefined custom solutions, you can
manually define them. To manually create a new custom solutions tailored to a
specific application environment:

1. Open the Monitoring and tuning folder and select the Custom solutions task.

2. Click Add / remove custom solution to display the Add / remove custom
solution portlet.

3. Enter a Custom solution name.

4. Enter an optional comment in the Comment field to help identify the custom
solution.

5. Click the boxes in the first column of the table to select one or more
components from the table of available components. This list of components
includes all application servers, Web servers, and databases currently
configured in this console.

6. If the component you require is not listed:
a. Select the type of component you need to add from the Select Action list,

then click Go. This brings you to the Add / remove custom solution for
that type of component.

b. Add the component, and then return to this task. The table now includes
the newly added component.

7. Click Add to list to add the new group.
If one or more of the components you selected has multiple instances

associated with it, you are prompted to select the instance to include in this
custom solution.



8. Test the connection to the new custom solution.

Tip: If the table contains a large number of items, you can use filtering and sorting
capabilities to manage the task more easily; see [“Viewing tables” on page 24|
for a description.

Testing the connection to a custom solution: To test the connection to a custom
solution, perform the following steps From the Add / remove component group
portlet:

1. Select the solution you want to test from the Custom solutions list.
2. Click Test connection to display the Test connection portlet.

3. Enter the User ID and Password for each component in the group. If you have
already accessed this component in the past, the user ID and password are
pre-filled.

4. Click Test to test the connection. The result is displayed in the Result column.
5. Click Close to return to the Add / remove a custom view task.

Administering a custom solution
You can use a custom solution to administer a set of components. To work with a
custom solution:

1. Open the Monitoring and tuning folder and select Custom solutions. The last
custom solution you worked with is displayed.

2. To work with a different custom solution, choose a different view using the
Select a custom solution list and click Go.

3. The individual components in the custom solution are displayed within a table,

one row per component. This table shows the Operational state of each
component and the highest level of Alert state for each component.

Note: If the table contains a large number of items, you can use filtering and

sorting capabilities to manage the task more easily; see [“Viewing tables” on|
for a description.

You can select one or more components of a custom solution to troubleshoot. Click
Analyze logs to invoke the log analyzer (see|“Using the log analyzer” on page 29)
for the selected components.

Starting and stopping components: To start or stop individual or multiple
components in a view perform these steps:

1. To use Start or Stop, you must select one or more rows in the table. You can
select an individual component by clicking Select for it. To select all rows in

the table, click the Select all icon ( ) at the top of the table. To deselect

all rows in the table, click the Deselect all icon (|
2. To start a stopped component, either click Select to the left of that component,
and then click Start, or click the Stopped link.

3. To stop a started component, either click Select to the left of that component,
and then click Stop, or click the Started link. Click OK on the resulting
confirmation dialog. If the link is displayed as Unavailable, you can click the
Unavailable link to start the component.
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If a database component is included, the list of components to be stopped includes
all databases on the same instance. You are prompted to force any users or
applications on those databases off the database to stop it. The default is to not
force users off the database. When the database stop process completes, the state is
Unavailable because it is not possible to connect to the database. If no error
message is displayed for the stop request, this generally means the stop is
successful.

To start the database again, click the Start link, or click Select to select the
database, and then click Start.

Tip: This also starts all databases on that server instance.

Monitoring components: You can view the alert status of the components in a
view, and adjust the thresholds that are used to set the alert states.

The Alert state column indicates the highest alert level for the component. For a
database, this is the same alert level shown in the Status - database task. For an
application server or a Web server, this level is based on CPU usage.

To see the CPU usage graph and view or change the thresholds for the various
alert levels, click the Alert state link for the server; the usage is shown for the
system and for the component instance (application server or Web server) on
Windows. For i5/0S (OS/400) the CPU usage shown is for the system only; the
CPU usage for individual components is not available.

To modify the thresholds for status reporting purposes, click Modify thresholds. A
portlet is displayed showing the current thresholds.

To modify the thresholds, type new numbers in the input boxes and click Apply.
To remove customized settings, click Reset to defaults.

Using the Troubleshooting functions

InfoCenter

The console provides a number of tasks to help you find whether there are
problems with the components you are managing, and to determine the nature of
any problems. The most basic functions available for use with all component types
are described in:

* |“Testing connections”]|

* |"Using the log analyzer” on page 29|

Additional functions are provided to assist in troubleshooting specific component
types, such as for specifying the log and trace capabilities. See the help
descriptions for each of those for further details.

Testing connections
If you suspect some problem exists with a particular component, you should
initially make sure that the console can connect to it successfully. To do that:

1. Select Troubleshooting > Test connection from the tasks in the navigation
frame.

2. Select a Component type:
* Application servers
* Web servers
* Databases
* Console agents
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3. Select a Component name.
4. Enter a User ID and Password for the component.
5. Click Test. The results are displayed in the area below the selections.

Note: Click User ID and password help if you are unsure about which user 1D

and password combination to supply (see [“User IDs and passwords” on|
for details).

Using the log analyzer

The log analyzer is an integral part of the Express Runtime console, and functions
in the same manner. Refer to the Log Analyzer help and InfoCenter for specific
instructions for using the analyzer functions.

Note: The console symptom database (see ['Symptom database” on page 79) is
automatically downloaded and installed for you. To use the symptom
database, select the console log messages to analyze and select Analyze
Selected Messages from the table menu.

Troubleshooting console agents

The console agent is a remote agent used in conjunction with the Express Runtime
management extensions. It is a small program installed on each system when the
first Express Runtime management extension is deployed to that system. The
console agent allows the console to connect to remote systems for the sole purpose
of running management tasks on those systems. The console agent is installed on
any computer that has a WebSphere Application Server — Express, IBM HTTP
Server, or the database component (DB2 UDB Express or Informix Dynamic Server
Express) installed. It is also installed where you have an application installed,
which is set up to utilize the log analyzer function of the console. The list of
available agents is maintained whenever you add or remove an application server,
Web server, or database to the console.

Using the console agent, you can perform the following management task:

Logs and trace
With this task, you can change the log settings for a given agent. To
manage the logs and trace levels:

1. Click Troubleshooting > Console agent > Logs and trace.
2. Select an agent.

3. Select the trace levels.

4. Click Apply to save your changes.

Note: You can also test the connection to a console agent. See
[connections” on page 28] for details.

Managing databases

This section describes the console facilities for managing databases. You can start
or stop databases, monitor the alert levels, and analyze the log files of databases.
You can also perform backup operations on databases.

To perform administrative tasks not available in the console, use the existing DB2
tools installed on the DB2 UDB Express server, or the tools on the Informix
Dynamic Server (IDS).

Note: Applying a middleware component hotfix or fixpack not offered through the
Express Runtime product might keep the Express Runtime console from
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managing the middleware component correctly. Check the Express Runtime
Support Web site or contact Express Runtime Support before you apply any
middleware hotfix or fixpack.

Managing the list of databases

You can add or remove databases to the list of databases managed from the
console, edit the information about a database, and test connections to the
database.

Note: If a database is not yet configured into the console, you can configure one
by clicking Configure databases; See ['Configuring Express Runtime|
[console” on page 25| for details.

To manually add a database to the list, perform the following steps:
1. Log in to the console and click Databases under the Work Items tab.
2. Click Status - database .

3. Click the Add / remove databases link in the top portlet.
4. Select a Component type.
5. Enter the fully-qualified Host name of the server where the database is

installed.

6. Enter the JMX port number (Simple Object Access Protocol (SOAP) connector
port) of the DB2 server instance. The default is 8888. This field does not apply
to DB2 for iSeries or to an Informix Dynamic Server Express server.

7. Enter the console agent port number. This port number was provided during
install of the management extension. The default is 7044. This port number
does not apply to DB2 for iSeries.

8. Enter the instance name for a DB2 UDB Express database. The default is DB2
on Windows and db2inst on Linux. This field does not apply to DB2 for
iSeries or to Informix Dynamic Server Express.

9. Enter the server name for an Informix Dynamic Server Express database.

10. Enter the database name. This is the database alias name as defined on the
DB2 or Informix Dynamic Server Express server, or the system name for DB2
on iSeries.

11. Enter the install path for an Informix Dynamic Server Express database.

12. Enter an optional comment, to describe the database.

13. Click Add to list. The database name is displayed in the Current databases
box.

You can edit the information for any database shown in the Current databases
box. Select one and click Edit, to display the parameters. Change any of the values,
and then click Apply, or click Cancel if you do not want to make the changes.

You can also take databases off the list of those being managed using the console.
Select one or more and click Remove.

Remember: Exercise care when removing databases from the list; this list is shared
with all other users of the Integrated Solutions Console.

Managing a database
You can use the console to monitor and manage any database contained in the list
of current databases.

To check the state of a database, perform the following steps:
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1. Log in to the console and open Databases under the Work Items tab.
2. Click the Status - database task.

The current operational state, last backup time, and highest alert state are
displayed for the selected database. The last backup time is blank if the database
has never been backed up. For Enter the server name for an Informix Dynamic
Server Express and DB2 on iSeries, some information is not available.

You can also use the console to perform administrative tasks for the selected
database:

“Troubleshooting a database”|

» |“Starting or stopping a database”]

» [“Backing up a database”|

“Viewing the alerts for a database” on page 32|

Troubleshooting a database: You can verify the connection to a database in the
list. Do this for any newly added database. To test a connection, use the
Troubleshooting > Test connections task; see [“Testing connections” on page 28| for
details.

Note: If an incorrect user ID or password is indicated, correct the mistake, and
then click Test. Other reasons for a failure include an incorrect host name,
agent port number, or J]MX port, missing management extensions, or a
network connectivity problem.

You can analyze the log files for a database. To analyze the logs, use the
Troubleshooting > Analyze logs task; see [“Using the log analyzer” on page 29 for
details.

Starting or stopping a database: To start a stopped database or stop a started
database:

1. Log in to the console and open Databases under the Work Items tab.
2. Click Status - database .

3. If the properties area shows that the database is stopped, you can start it by
clicking Start.

4. If the properties area shows that the database is started, you can stop it by
clicking Stop. Click OK on the resulting confirmation dialog.

The confirmation list of databases to be stopped includes all databases on the same
DB2 instance or IDS server. You are prompted to force any users or applications on
those databases off the database in order to stop it. The default is to not force users
off the database. When the database stop process has completed, the state shows
unavailable because it is not possible to connect to the database. If no error
message is displayed for the stop request, this generally means the stop was
successful.

To start the database again, click the Start link.
Backing up a database: From the Details task you can perform a backup

operation for a database. The procedures differ, based on the system type where
the database is located:

» For iSeries, see|“Backing up a database (iSeries)” on page 32|
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 For Windows or Linux, see”Backing up a database (Windows or Linux)”|

Backing up a database (iSeries):
1. Log in to the console and open Databases under the Work Items tab.
2. Click the Status - database task.

3. To perform a backup of the database, click the Backup link. Alternatively, you
can click the Backup task under Databases in the Work Items tab. The Backup
database portlet is displayed.

4. The Select one or more schemas to back up table displays a list of all schemas,
the description of each schema, and the last time it was backed up. Select one
or more by clicking the box in the Select column of the table.

5. Enter the location or click Browse.

6. Click OK to perform the backup. Click Cancel to quit without performing the
backup.

Backing up a database (Windows or Linux):
1. Log in to the console and open Databases under the Work Items tab.
2. Click the Status - database task.

3. To perform a backup of the database, click the Backup link. Alternatively, you
can click the Backup task under Databases in the Work Items tab. The Backup
database portlet is displayed.

4. If storing to directory or tape, enter the location or click Browse to browse to
the location.

5. For a Tivoli® Storage Manager (TSM) backup, select the number of sessions to
be created between the DB2 instance and TSM. The default is 1. The Location
field defaults to the value from the previous backup of the selected database.

Note: To configure for TSM use with IDS, refer to
[http:/ /publib.boulder.ibm.com/infocenter /ids9help /index.jsp}

6. For backup of IDS databases, optionally change the default location shown.
(The file name is timestamp and an extension of bak.)

7. The field Type of backup to perform is displayed if the online backup option
is enabled for this (DB2) database; choose whether or not to perform an online
or offline backup. If this choice is not shown, an offline backup is performed.

8. Click OK to perform the backup. Click Cancel to quit without performing the
backup.

Browsing for backup location: When you click Browse in the Backup portlet, the
Browse portlet is displayed, showing a directory tree. Use it to locate and select the
directory to use for the backup:

1. Click the squares to open and close tree nodes.

2. Click a node name to select that directory location and return to the Backup
portlet.

3. Click Cancel to return without selecting a location.

Viewing the alerts for a database: To view the alerts for a database:
1. Log in to the console and open Databases under the Work Item tab.
2. Click the Status - database task.

3. View the alerts by clicking the Health link. Alternatively, you can click the
Health task under Databases in the Work Items tab. This opens the Alerts


http://publib.boulder.ibm.com/infocenter/ids9help/index.jsp

portlet, which lists in a table the alerts for the database. The table displays all
alerts sorted by Alert state, Timestamp, and Object name.

Tips:
* If the table is empty, the database is not configured for alerts, or there

are no alerts for the selected database, or the tablespace size is too
small (less than 8MB) for alerts to be processed.

* If the table contains a large number of items, you can use filtering and
sorting capabilities to manage the task more easily; see

lsetting up the console” on page 21| for a description.

Retrieving recommended actions for a specific alert: You can view the actions
recommended for handling an alert. From the Alerts portlet:

1. Click the Alert state value for the database. This displays the
Recommendations portlet.

2. Click Done after reviewing the recommendations.
3. To refresh the list of alerts, click Refresh.

Viewing the health of all managed databases
To display a summary of the health of all the databases you configured, perform
the following steps:

1. Log in to the console and open Manage System Health > Database health
under the Work Items tab.

2. Click the DB2 Express status task. A table displays the highest alert level for
each of the current databases. The table is sorted by highest number of Alarm,
Warning, and Attention alerts.

Tip: If the table contains a large number of items, you can use filtering and

sorting capabilities to manage the task more easily; see|“Viewing tables”|
for a description.
3. To view all the alerts for a database, click the name link for that database. This

displays the Alerts portlet for the database.
4. Click Refresh to update the list.

Managing application servers

This section describes the console facilities for managing application servers. You
can start or stop servers, view or modify server information, and analyze logs for
the server.

Note: Applying a middleware component hotfix or fixpack not offered through the
Express Runtime product might keep the Express Runtime console from
managing the middleware component correctly. Check the Express Runtime
Support Web site or contact Express Runtime Support before you apply any
middleware hotfix or fixpack.

Managing the list of servers

Note: If a server is no yet configured into the console, you can configure one by
clicking Configure servers; See [“Configuring Express Runtime console” on|
-

for details.

You can manually add or remove servers to the list of servers managed from the
console, edit the information about a server, and test connections to the server.
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To add a server to the list:

1. Log in to the console and open Servers > Application servers under the Work
Item tab.

Click the Status - application server task.
Click the Add / remove servers link in the top portlet.
Enter the fully qualified host name of the server.

o k0N

Enter the port number for the WebSphere Application Server - Express
administrative console. The default port value for the administration console is
9060.

6. Enter the console agent port number. This port number was provided during
install of the management extension. The default is 7044.

7. Enter an optional comment, to describe the server, if desired.
8. Click Add. The server name appears in the Current servers field.

You can edit the information for any server shown in the Current servers field.
Select one and click Edit to display the parameters. Change any of the values, and
then click Apply, or click Cancel if you do not want to record the changes.

You can also take servers off the list of those being managed using the console.
Select one or more from the list and click Remove.

Managing an application server
You can use the console to monitor and manage any server contained in the list of
current servers.

To check the state of a server, perform the following steps:

1. Log in to the console and open Servers > Application servers under the Work
Item tab.

2. Click the Status - application server task.
The current Operational state is displayed for the selected server.

You can also use the console to perform administrative tasks for the selected
server:

« [“Troubleshooting an application server’]

« |“Starting or stopping an application server” on page 35|

« |"Viewing information on an application server” on page 35|

* [“Viewing and modifying server settings” on page 35|

Troubleshooting an application server: You can verify the connection to an
application server in the list. Do this for any newly added server. To test a
connection, use the Troubleshooting > Test connections task; see

lconnections” on page 2§ for details.

Note: Common reasons for failure include an incorrect host name or port, missing
management extensions, an inoperative console agent, or a network
connectivity problem. You can click More details for help with
troubleshooting.

You can analyze the log files for an application server. To analyze the logs, use the
Troubleshooting > Analyze logs task; see [“Using the log analyzer” on page 29 for
details.
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Starting or stopping an application server: To start a stopped server or stop a
started server:

1. Log in to the console and open Servers > Application servers under the Work
Item tab.

2. Click the Status - application server task.

3. If the server is shown as stopped, you can start it by selecting it in the table
and clicking Start.

4. If the server is shown as started, you can stop it by selecting it in the table and
clicking Stop. Click OK on the resulting confirmation dialog.

Viewing information on an application server: This portlet displays the
information from the WebSphere Application Server — Express server that you
select. The information is the same as would be seen from the WebSphere
Application Server — Express console.

To view information from the WebSphere Application Server — Express server:

1. Log in to the console and open Servers > Application servers under the Work
Item tab.

2. Click the Status - application server task.

3. Click the Server information link at the top of the portlet. This launches a new
portlet, with information about the server, such as the version number.

Viewing and modifying server settings: Application Server and Web Application
settings can be viewed or modified just as they are in the WebSphere System
Console that ships with the WebSphere Application Server - Express product.

The settings that can be viewed or modified by a specific user are dependent on
which groups to which that user belongs. The console includes three groups:
SystemAdmin, SecurityAdmin, and SolutionsProvider. Users belonging to more
than one group can filter the set of tasks to show only those for a specific group by
using the View list in the navigation pane.

To view or modify the WebSphere Application Server - Express server settings:

1. Log in to the console and open the Servers > Application servers task under
the Work Item tab.

2. Click the Application Server - Express administration task (for example,
Application servers). The Application servers task is displayed in the work
area for the selected server.

3. Use the task just as in the console that ships with WebSphere Application
Server - Express.

4. Click the More information about this page link within the task for more
information about managing Application Server - Express. When the link is
clicked, the WebSphere Application Server - Express help text is displayed in a
separate browser window.

Managing application server profiles

An application server profile is created using the profile creation tool. (Refer to the
WebSphere Application Server — Express information center for more details.) A
profile is used for another application server instance at the same installation
location, but with a different set of ports. A profile is added, edited, and removed
as if it were another WebSphere Application Server — Express server.
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You cannot manage more than one profile on the same server at the same time.
You are logged out of the profile if you have already accessed another profile on
the same server. If you have no open tasks pointing to the first profile accessed,
then you are logged out. However, if you have any open tasks pointing to the first
profile accessed, and you attempt to switch to another profile, you are prompted to
correct the profile conflict. Click OK to close all the tasks associated with the first
profile, log out, and switch to the second profile. Click Cancel to continue with the
first profile.

Managing Web servers

InfoCenter

This section describes the console facilities for managing Web servers. You can start
or stop servers, view logs, anlayze log files, and modify log settings.

Applying a middleware component hotfix or fixpack not offered through the
Express Runtime product might keep the Express Runtime console from managing
the middleware component correctly. Check the Express Runtime Support Web site
or contact Express Runtime Support before you apply any middleware hotfix or
fixpack.

Managing the list of Web servers

Note: If a server is not yet configured into the console, you can configure one by
clicking Configure servers; See [“Configuring Express Runtime console” on|
-

for details.

You can manually add or remove servers to the list of servers managed from the
console, edit the information about a server, and test connections to the server.

To manually add a server to the list, perform the following steps:

1. Log in to the console and open Servers > Web servers under the Work Item
tab.

Click the Status - Web server task.
Click the Add / remove servers link in the top portlet.
Enter the fully qualified host name of the server.

Al A

Enter the console agent port number. This port number is provided during
install of the management extension. The default is 7044.

12

Enter an optional comment, to describe the server.

7. Click Add. The server name is displayed in the Current servers field.

You can edit the information for any server shown in the Current servers field.
Select one and click Edit, to display the parameters. Change any of the values, and
click Apply, or click Cancel if you do not want to record the changes.

You can also take servers off the list of those being managed using the console.
Select one and click Remove.

Managing a Web server
You can use the console to monitor and manage any server contained in the list of
current servers, and to analyze the logs for the server.

To check the state of a server, perform the following tasks:

1. Log in to the console and open Servers > Web servers under the Work Item
tab.

2. Click the Status - Web server task.
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The current operational state is displayed for all instances of the selected server.

You can use the console to perform the following administrative tasks for a
selected server:

+ |[“Troubleshooting a Web server’|

» |“Starting or stopping a Web server”]

+ [“Modifying log settings”]

Troubleshooting a Web server: You can verify the connection to an application
server in the list. Do this for any newly added server. To test a connection, use the
Troubleshooting > Test connections task; see [“Testing connections” on page 28| for
details.

If an incorrect user ID or password is indicated, correct the mistake, and then click
Note: Test

Common reasons for a failure include an incorrect host name or port number,
missing management extensions, an inoperative console agent, or a network
connectivity problem. You can click More details for help with troubleshooting.

You can analyze the log files for a Web server. To analyze the logs, use the
Troubleshooting > Analyze logs task; see [“Using the log analyzer” on page 29 for
details.

Starting or stopping a Web server: To start a stopped server or stop a started
server:

1. Log in to the console and open Servers > Web servers under the Work Item
tab.

2. Click the Status - Web server task.
3. If the server is shown as stopped you can start it by clicking the Start link.

4. If the server is shown as started you can stop it by clicking the Stop link. Click
OK on the resulting confirmation dialog.

Modifying log settings: To modify the Web server log settings:

1. Log in to the console and open Troubleshooting > Web Servers > Logs and
trace under the Work Item tab.

2. Click Select for the Server instance that you want to modify.

w

Click OK to display the Logs and trace portlet.

B

To change the log file location, enter the new location in the Log file field, or
click Browse (see [‘Browsing for a log file location”).

Select the minimal message level to log.
Choose whether host name lookups are logged.
Click Apply to save your changes to the server.

© N o o

Click the List of instances link if you want to go back and select another
instance.

Browsing for a log file location: When you click Browse in the Logs and trace
portlet, the Browse portlet is displayed, and shows a directory tree. Use it to locate
and select the directory and set a file name for storing log files on the server:

1. Click the squares to open and close tree nodes.
2. Click a folder name to select that folder location.
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3. Click a Filename in the table to select an existing log.
4. Click OK to save your selection and return to the Logs and trace portlet.
5. Click Cancel to return without saving your selection.

Express Runtime console help topics
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Express Runtime console help topics

InfoCenter

All of the help topics for the Express Runtime console portlets are contained in the

following sections. You can reach a specific topic by clicking the help icon (ﬂ) on
the portlet title bar. You can also use the table of contents to locate other related
help topics, or any other InfoCenter topic.

There are major sections for each of the installed console modules.

Note: You will not see the help topics for a console module that is not installed;
however, there are descriptions of all of the modules, and instructions for
their use, in other parts of the InfoCenter.

The topics within each major section are titled the same as the portlets which link
to them.

Common help topics
You might be linked to a help topic in this section from any of the components of
the Express Runtime console.

Common help topics: You might be linked to a help topic in this section from
any of the components of the Express Runtime console.

User IDs and passwords: There are numerous user IDs and passwords required for
managing the middleware components from the console. This topic provides a
summary of them, and some guidance as to which ones are required for particular
situations.

Note: Generally the user IDs and passwords you are asked to supply are for the
middleware components that you are managing with the console. However,
there are some places where you must supply a user ID and password for
the operating system where the middleware component is located; iSeries
users must have *ALLOB]J, *SAVSYS, *IOSYSCFG, and *JOBCTL authority.
These situations arise when you are performing the following tasks:

 Configuring the console
* Analyzing log files

Use the following table to determine what type of user ID and password
combination is needed:

Management extension Operating system User ID and password type

IBM HTTP Server All Windows platforms Any valid operating system
user ID and password with
administration authority

IBM HTTP Server All Linux platforms Any valid operating system
user ID and password with
root authority
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Management extension

Operating system

User ID and password type

IBM HTTP Server

i5/0S (0S/400)

Any valid operating system
user ID and password that
has *ALLOB]J, *SAVSYS,
*JOSYSCFG, and *JOBCTL
authority

WebSphere Application
Server — Express

All Windows platforms

The user ID and password
used to secure the
WebSphere Application
Server — Express server

WebSphere Application
Server — Express

All Linux platforms

The user ID and password
used to secure the
WebSphere Application
Server — Express server

WebSphere Application
Server — Express

i5/0S (0S/400)

The user ID and password
used to secure the
WebSphere Application
Server — Express server and
with *ALLOB]J, *SAVSYS,
*IOSYSCFG, and *JOBCTL
authority

DB2 UDB Express

All Windows platforms

Any valid DB2 admin user
ID and password

DB2 UDB Express

All Linux platforms

Any valid DB2 admin user
ID and password

DB2 UDB Express

i5/0S (0S/400)

Any valid operating system
user ID and password that
has *ALLOB]J, *SAVSYS,
*JOSYSCFG, and *JOBCTL
authority

Informix Dynamic Server
Express

All Windows platforms

Any valid Informix Dynamic
Server Express admin user
ID and password

Informix Dynamic Server
Express

All Linux platforms

Any valid Informix Dynamic
Server Express admin user
ID and password

Confirm removal: This portlet can appear for any of the components of the Express

Runtime console. Whenever you ask to remove (delete)

an instance of a component

(for example, a server) or a host name from the console configuration, you are
asked to confirm that the action is desired. Click Yes to remove the component.

Click No to leave it as is.

Localhost not usable as name: This portlet can appear for any of the components of
the Express Runtime console. Whenever you attempt to add a host name or server
to the console, and the host name specified or detected by the program is localhost.
This name is not valid for the console.

The console accepts fully-qualified host names (for instance,
hostname.mycompany.com) or complete Internet Protocol (IP) addresses (for

instance, 192.168.1.1).
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The message might show that the program determined what the correct host name
should be; the detected name is shown for your verification. If there is more than
one possible substitute for the host name, a list of these names is shown; if
appropriate, select the host name to use.

Click OK to accept or make the change.

Click Cancel if you want to go back to the previous task, without adding the host
name. This might be your only choice, if the program could not determine a
suitable fully-qualified host name; in that case, you should adjust the host name in
your computer configuration.

SSL certificate overview: Communication between remote servers and the Express
Runtime console is encrypted using secure sockets layer version 3 (SSLv3).
Information transmitted using SSLv3 cannot be viewed or changed by others.
SSLv3 secures information by using SSL certificates, which contain information
about the remote server and information about the issuer of the certificate.

The server you are attempting to administer has been configured to support SSL
certificates. To proceed, you must review the server’s certificate and declare it
trusted. Review this certificate and decide if it should be declared a trusted
certificate. If so, click Yes.

Note: Once a certificate has been declared trusted, it will continue to be used for
all future communications with this server.

CAUTION:

If you do not recognize the Common Name or IP address of the issuer, do not
accept this certificate. Accepting an unrecognized SSL certificate is a security
risk.

Note: You should have obtained a certificate during installation of the console; see
[“Using a certificate from a certifying authority” on page 10|if you wish to
replace the self-signed certificate with one from a certifying authority.

To learn more about SSL certificates and security refer to
http:/ / www.freessl.com /fag.html|

Function not found: You have selected a function that is not available. Either it is in
a component that is not installed, or there was an internal error.

No help file available: No help file could be retrieved; refer to the table of contents
for the InfoCenter to locate the information about your task.

Getting started with Express Runtime console
This portlet displays a set of instructions and links to assist you in starting to use
the console. The narrative should be self-explanatory. As noted on the portlet

display, you can access this help for the portlet by clicking the help icon (E) in
the portlet title bar. The same link is active on any of the portlets in the console.

Note: You can also access the InfoCenter topics for this module of the console; see
[“Getting started with the console” on page 25]If you are using the console
for the first time, you should review the description of the basic structure
and operation of the console.
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You can use the links on this portlet to access the key functions of the console, or
you can use the navigation frame to access those functions.

Note: Whenever you click a link to activate a task (in the navigation frame or in
the text of this portlet display) a new task is started in the console. This task
is persistent, and continues running in the background after you invoke
another task. You can switch back to the dormant task by clicking the button
at top of the page (in the grey bar) for the task. When you have completed a
task, you must take an action to close it. (On this Getting started task, click
Done).

Configure Express Runtime console
With this module of the console you can locate the middleware components and
custom solutions which you want to manage, and configure them into the console.

Configure console: The initial panel of the ConfigureExpress Runtime console
task helps you select host names of the computers upon which you want to locate
components. For each host name that you want to configure, you must provide a
User ID and Password for the host operating system. From this panel, you can
perform the following actions:

¢ Add or Remove host names
* Configure components

* Configure custom solutions

Note: A custom solution is a collection of components, such as application servers,
Web servers, and databases. A custom solution is designed to monitor, start,
and stop a set of components having something in common. A typical
solution is one consisting of the components required to host a particular
application.

To add or remove host names, click the Add/Remove unconfigured host names
link (on the upper right hand corner of the portlet panel) and follow the
instructions on the Add/Remove unconfigured host names panel.

Note: An unconfigured host name is the host name of any computer in your
network which has middleware components installed on it using the
Express Runtime deployer, when that host has not yet been configured into
the console.

To configure components on any of the host names that are displayed in the list,
select the check boxes corresponding to the host names that you want to locate
components on, and click Configure components.

Note: This portlet is used to configure specific types of components as well as
configuring all component types on a host. When the portlet is invoked for a
specific component type, click the specific button (for example, Configure
databases).

To configure custom solutions on any of the host names that are displayed in the
list, select the check boxes corresponding to the host names that you want to

configure custom solutions on, and click Configure custom solutions.

Note: This portlet is used to configure specific types of components as well as
configuring custom solutions; this button may not appear.
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Add/Remove unconfigured host names: The Add/Remove unconfigured host
names panel helps you add host names that you can locate components or custom
solutions on. To add a host name, you need to know the fully-qualified host name
that has the components or custom solutions on it, and the console agent port that
the host uses. You can provide multiple console agent ports for any host. You can
also edit host names that already are displayed in the Add/Remove panel.

To add a host, provide a fully-qualified host name and console agent port number,
and click Add to list.

To edit a host, select the host from the list and click Edit. Modify the
fully-qualified host name or port, and click Apply.

To remove a host, select a host and click Remove.

When you are finished adding or removing host names, click Done to return to the
locate task initial panel.

Configure components: The Configure components task finds components on the
hosts that you select in the Configure console panel. When this task discovers
components, it displays the components it finds in the form of a table.

Note: There can be a delay in completing the table, depending on the number and
location of the hosts. Click Refresh to view the latest results; a message is
displayed giving the status of the operation.

The Configuration status of the discovered components can be one of the
following:

Configured
The console already has located the component and has the required
information to connect to the component.

Not in console
The component is new to the console, and information needs to be
provided to connect.

Needs an update
The console already has located the component, but additional or new
information is required to connect to the component.

Select the desired hosts from the table and click Add components to configure
them into the console.

Note: This portlet is used to configure specific types of components as well as
configuring all component types on a host. When the portlet is invoked for a
specific component type, click the specific button (for example, Add
databases).

Note: If the Configuration status shows Needs an update, the add function
performs the update to the console configuration.

Note: If the Configuration status shows Click here to monitor, click the link to
view the status portlet for that component.

Click Done when you are finished.



Configure custom solutions: The Configure custom solutions task finds custom
solutions on the hosts that you select in the Configure console panel. When this
task discovers custom solutions it returns them in the form of a table.

Note: There can be a delay in completing the table, depending on the number and
location of the hosts. Click Refresh to view the latest results; a message is
displayed giving the status of the operation.

The Configuration status of the custom solutions that are discovered can be one of
the following:

Configured
The console already has located the custom solution and has the required
information to connect to the custom solution.

Not in console
The custom solution is new to the console, and information needs to be
provided to connect.

Needs an update
The console already has located the custom solution but additional or new
information is required to connect to the custom solution.

Select the desired hosts from the table and click Add custom solutions to
configure them into the console.

Note: If the Configuration status shows Needs an update, the add function
performs the update to the console configuration.

Note: If the Configuration status shows Click here to monitor, click the link to
view the status portlet for that component.

Click Done when you are finished.

Note: To see a list of the components contained in a custom solution, click its
name in the table; the list of components is displayed.

Custom solutions

With this module of the console you can administer one or more custom solutions.
A custom solution is a grouping of components (such as databases or Web servers)
that you can manage together.

Select custom solutions: Use this portlet to select and work with a custom
solution.

Note: You can also access the InfoCenter topics for this module of the console; see
[“Using custom solutions” on page 26.|

The Custom solutions area displays the name of the currently selected custom
solution. To display another custom solution, select it from the list and click Go.

If the custom solution is not shown in the list, configure it by clicking Configure
custom solution.

Note: The custom solution can only be located and configured if it has been
predefined; see [‘Defining custom solutions” on page 26| for details.
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You may also define a new custom solution by clicking Add / remove custom
solution.

Add/remove custom solution: Use this portlet to manage the list of custom

solutions available for viewing within the console. You can manually add new
custom solutions, edit or delete existing custom solutions, and test the connections
to the components within a specific custom solution.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Using custom solutions” on page 26|

Add a custom solution

To manually add a new custom solution:
1. Enter a Name for the new custom solution.
2. Optionally, enter a short Comment or description of the new custom solution.

3. Select one or more components from the list of all currently configured
components. If you cannot find a component:

a. Click the appropriate Add entry on the — Select Action — menu.
Click Go.

Add the new component.

Test the connection to the component

Click Done.

The component is now in the table.

4. Click Add to list.

If one or more of the components you selected has multiple instances
associated with it, you are prompted to select the instance to include in this

group.

® oo o

Current custom solutions

This box contains the list of currently defined custom solutions. You can edit,
remove, and test the connection to a custom solution by selecting the group and
clicking the appropriate button.

Portlet fields, buttons, and links

The purpose, default value (if applicable) and action for the fields, buttons and
links used by this portlet are as follows:

Custom solution name
This is the name for the custom solution.

Comment
This is an optional description for the custom solution.

Components table
This is a list of the currently configured components. These components
can be included in a custom solution. Each entry of the table has the
following fields:

Component name
This is the name of the component.

Component type
This is the type of the component, for example, database.



Server This is the name of the server on which the component is running.

Add to list
Click to add the component described by the table row as a new custom
solution.

Current custom solutions
This is a list of the currently configured custom solutions.

Edit  Click to edit the selected custom solution. The configuration information
for the solution is shown in the Custom solution name, Comment, and in
the table of existing components. You can change any settings. To change
just the instances included in a custom solution, click Edit, then click
Apply. You are prompted to select the instances to include in the solution.

Apply Click to save the changes you made to the custom solution.

Cancel
Click to cancel the changes you made to the custom solution.

Remove
Click to remove the selected custom solution from the console
configuration.

Test connection
Click to display the portlet to test the connection with the selected custom
solution.

Done Click to close this portlet.

Test connection to a custom solution: Use this portlet to test the connection to
the components in a custom solution.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Using custom solutions” on page 26.|

You can test the connection to each of the components included in the custom
solution. The table contains the names of all the components to be tested. You can
also enter the administrator user ID and password. If you previously had
authenticated access to the component, the user ID and password are filled in.

Enter the User ID and Password for all of the servers, and then click Test. Each
component is tested in turn and the result of the test is shown in the Result
column. If an error occurs, or the test fails, a message is shown.

Note: Click User ID and password help if you are unsure about which user ID
and password combination to supply.

The user ID and password is stored for each server that connects successfully.
Subsequent communication with these servers uses these stored values.

Portlet fields, buttons, and links

The purpose, default value (if applicable) and action for the fields, buttons, and
links used by this portlet are as follows:

Component name
This is the name of the component.

Server This is the name of the server on which the component is running.
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User ID
This is an administrator User ID for the component.

Password
This is an administrator password for the component.

Result This is the result of the test.

Test  Click to test all the components.

Close Click to close the Test connection portlet.

Troubleshooting: For more information about correcting errors that occur when

attempting to connect to a component, refer to the troubleshooting information for
the failing component:

* [“Troubleshooting databases” on page 73
* |“Troubleshooting IBM HTTP Server” on page 73|
* [“Troubleshooting WebSphere Application Server — Express” on page 73|

Custom solution: This portlet allows you to work with a number of components
simultaneously.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Using custom solutions” on page 26.|

The components might be all of one type, or of different types. Three special
custom solutions are predefined and cannot be edited or removed:

 All application servers
e All Web servers
e All databases

These special names are shown in the title bar of the portlet.

The custom solution table shows information about multiple components. You can
interact with a component by clicking one of the links in the table, or by selecting
the box for the row for the component. You can select multiple boxes. When you
have selected one or more boxes, click the Start button to start the selected
components or the Stop button to stop the selected components.

If a database component is included, the list of components to be stopped includes
all databases on the same instance. You are prompted to force any users or
applications on those databases off the database to stop it. The default is to not
force users off. When the database stop completes, the state is Unavailable because
it is not possible to connect to the database. If no error message is displayed on the
stop request, this generally means the stop is successful.

To start the database again, click the database Select box and click Start.
Note: This also starts all databases on that server instance.
Portlet fields, buttons and links

The purpose, default value (if applicable) and/or action for the fields, buttons and
links used by this portlet are:

Select This column contains the selection boxes. Click one or more boxes to select
components to act on.



Component name
This is the name of the component and the instance (if applicable) this row
represents.

Component type
This is the type of component this row represents.

Server This is the server the component is installed on.

Operational state
This is the operational state of the component. The state might be started,
stopped, unavailable, or unknown. Started means the component is
running. Stopped means the component is not running. Unavailable
generally means the database component is stopped, but it is possibly
started but unreachable. Unknown means that the server on which the
component is running cannot be reached.

Alert state
This is the highest configured alert state (Normal, Attention, Warning,
Alarm) that has been reported for the component. If a component is not
configured to provide alerts, or if a connection cannot be established, the

status is Unknown. To learn more about the status, click the status value
link.

Analyze logs
Click to open the log analyzer portlet for the selected components.

Done Click to close this portlet.
Start  Click to start the selected components.
Stop  Click to stop the selected components.
Refresh

Click to refresh the entire table.

CPU usage: This portlet allows you to view a snapshot of the CPU usage history
of a system and of a specific process running on the system. The process utilization
is calculated to represent the approximate CPU usage of a specific component.

Note: The process usage information is not provided for Linux systems.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Using custom solutions” on page 26.|

Portlet fields, buttons and links

The purpose, default value (if applicable) and/or action for the fields, buttons and
links used by this portlet are:

Refresh
Click to refresh the displayed graph.

Modify Thresholds
Click to open the Modify thresholds portlet, allowing you to modify the
instance thresholds being used to determine the alert state of an instance.
The alert state is the higher of the system threshold or the instance
threshold.

Note: This button is disabled for Linux systems.

Done Click to close this portlet.
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Modify thresholds: This portlet allows you to modify the instance thresholds being
used to determine whether the alert state of an instance is normal, attention,
warning, or alarm. The alert state is the higher of the system threshold or the
instance threshold.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Using custom solutions” on page 26.|

Portlet fields, buttons and links

The purpose, default value (if applicable) and/or action for the fields, buttons and
links used by this portlet are:

Attention
This is the threshold for attention state. When the average CPU usage
meets or exceeds this threshold, the alert state is set to a minimum of
Attention. When the average CPU usage is less than this threshold, the
alert state is set to Normal.

Warning
This is the threshold for warning state. When the average CPU usage
meets or exceeds this threshold, the alert state is set to a minimum of
Warning. When the average CPU usage is less than this threshold, the alert
state is set to Attention or Normal.

Alarm This is the threshold for alarm state. When the average CPU usage meets
or exceeds this threshold, the alert state is set to Alarm. When the average
CPU usage is less than this threshold, the alert state is set to Warning,
Attention, or Normal.

Apply Click this to apply (save) the modified values.

Reset to default
Click this to reset the values to the default values.

Cancel
Click this to cancel without saving the values.

Troubleshooting
The topics in this section apply to all types of components. The troubleshooting
tasks are:

[Test connection|
You can use this task to determine whether the console can connect to a
given component; if the connection is not working, you can determine the
cause.

Analyze logs

You can use the log analyzer to examine the log files of one or more
components, and determine what events have occurred to cause the
problem you are investigating.

[“Console agents” on page 49|
You can configure the log and trace capability of the console agents in the
hosts where your middleware components are installed; this can make it
possible to collect the information needed for analyzing the log files.

Test connection: Use this portlet to test the connection to any components.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Testing connections” on page 28]




You can test the connection to each of the components configured in the console.
Note: If no components are configured, click Configure console.

You must enter the administrator user ID and password. If you previously had
authenticated access to the component, the user ID and password are filled in.

Note: Click User ID and password help if you are unsure about which user ID
and password combination to supply.

Select the Component type and Component name, and enter the User ID and
Password for the server, and then click Test. The component is tested and the
result of the test is shown in the Test results area. If an error occurs, or the test
fails, a message is shown.

The user ID and password is stored for each server that connects successfully.
Subsequent communication with these servers uses these stored values.

Portlet fields, buttons, and links
The purpose, default value (if applicable) and action for the fields, buttons, and

links used by this portlet are as follows:

Component type
Select the type of component for which you want to test the connection.
You can choose from application servers, console agents, databases or Web
servers. For console agent components, no User ID or password is
required.

Component name
This is the name of the component.

User ID
This is an administrator User ID for the component.

Password
This is an administrator password for the component.

Test  Click to test all the components.

Cancel
Click to close the Test connection portlet.

Test results
This is the result of the test.

Troubleshooting

For more information about failure when attempting to connect to a component
refer to the troubleshooting information for the failing component. See

lconnectivity problems” on page 72| for more information.

Console agents: With this module of the console you can administer one or more
console agents.

Select console agents: Use this portlet to select and work with a console agent.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Troubleshooting console agents” on page 29.|
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The Console Agents area displays the name of the server containing an instance of
the console agent with the currently selected console agent shown. When you
configure a DB2 UDB Express instance, Informix Dynamic Server Express server,
Web server, or WebSphere Application Server — Expressserver, that server is added
to the list.

To display another server console agent, select it from the list and click Go. If the
console agent is not shown in the list, configure it.

Logs and trace: This portlet allows you to set trace levels for the console agent.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Troubleshooting console agents” on page 29|

The Trace levels area displays the various trace levels for a console agent:
* Error conditions

* Warning conditions

* Debug-level messages

You can enable any of the trace messages by clicking the corresponding box. You
can also disable the trace level by deselecting the corresponding box. Click Apply
to submit the changes.

Portlet fields, buttons and links
The purpose, default value (if applicable) and/or action for the fields, buttons and

links used by this portlet are:

Error conditions
This selection turns on/off error conditions for the console agent. This level
is enabled by default.

Warning conditions
This selection turns on/off warning conditions for the console agent. This
level is enabled by default.

Debug-level messages
This selection turns on/off debug-level messages for the console agent.

Apply Click to save the new settings.

IBM database administration

InfoCenter

IBM database administration
With this component of the console you can administer one or more instances of
an IBM DB2 Server or Informix Dynamic Server Express (IDS).

Select database: Use this portlet to select and work with a server and database.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Managing databases” on page 29.|

The Databases area displays the name of the server and database that is currently
selected. When you configure a database, that database is added to the list.



To display another database, select it from the list and click Go. If the database is
not shown in the list, you must first configure it by clicking Configure databases.
ClickAdd / remove databases if you want to manually define a new database to be
configured.

Note: You should usually use the Configure console task to configure databases
into the console. Use this task if the configure task was not successful.

Add/remove database: Use this portlet to manage the list of databases available
for viewing within the console. You can add new databases, edit or delete existing
databases, and test the connections to the databases.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Managing databases” on page 29.|

Add a database

To add a new database:

1. Select a Component type.

2. Enter a Host name for the server where the database resides.
3. Enter the JMX port number for the database server.

Note: For iSeries databases, a JMX port number and Instance name is not
required.

4. Enter the console Agent port number for the server.
5. Enter the Instance name for the database.

Note: For an Informix Dynamic Server Express database, this is Server. The
field is not present for an iSeries database.

6. Enter the Database name.
7. Optionally, enter a short Comment or description of the new database.
8. Click Add to list.

Current databases

This area contains the list of currently defined databases. You can edit, remove, or
test the connection to a database by selecting the database and clicking the
appropriate button.

Portlet fields, buttons, and links

The purpose, default value (if applicable) and action for the fields, buttons, and
links used by this portlet are as follows:

Component type
This is the type of database:
e DB2 (Windows or Linux)
* DB2 (ISeries)
* Informix Dynamic Server

Host name
This is the name for the server where the database resides.

JMX port
This is the JMX port number for the database server. The default port
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value for the database server is 8888 for Linux and Windows servers. The
port is not required for iSeries servers.

Agent port
This is the port number for the console agent for the database server. The
value of this port is configured at install time and defaults to 7044.

Instance
This is a name describing the specific instance of a DB2 UDB
Expressdatabase server.

Server This is a name describing the specific Informix Dynamic Server Express
database server.

Database
This is the actual name of the database on the server.

Comment
This is an optional comment describing the database.

Add to list
Click to add the server to the list of databases.

Current® databases
This is a list of the currently configured databases.

Edit  Click to edit the selected database. Change any of the settings and click
Apply to save the changes.

Apply Click to save the changes made to the database.

Cancel
Click to cancels the changes made to the database.

Remove
Click to remove the selected database from the console configuration.

Test connection
Click to display the portlet to test the connection with the selected
database.

Done Click to close this portlet.
Test connection: Use this portlet to test the connection to a database.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Managing databases” on page 29.|

You can test the connection to any of the databases included in the list. The table
contains the names of all the databases to be tested. Enter the user ID and
password for the DB2 instance or IDS database owner. If you previously had
authenticated access to the databases, the user ID and password fields are filled in.

Note: Click User ID and password help if you are unsure about which user ID
and password combination to supply.

Enter the User ID and Password for the database and click Test. The database is
tested and the result of the test is shown in the Result column. If an error occurs,

or the test fails, a message is shown.

The user ID and password is stored for a database that connects successfully.
Subsequent communication with this database uses these stored values.
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Portlet fields, buttons, and links

The purpose, default value (if applicable) and action for the fields, buttons, and
links used by this portlet are as follows:

Database
This is the actual name of the database on the server.

User ID
This is the administrator user ID for the database.

Password
This is the administrator password for the database.

Result This is the result of the test.

Test  Click to test the connection to the database.

Close Click to close the Test connection portlet.

Troubleshooting: For more information about correcting errors that occur when
attempting to connect to a component, refer to the troubleshooting information for

the failing component. See [“Troubleshooting databases” on page 73| for more
information.

Backing up databases: The help for database backup differs depending on the
type of system the database is running on:

+ |“Backup (iSeries)’]

+ |“Backup (Windows/Linux)” on page 54|

Backup (iSeries): Use this portlet to perform a one-step backup of the selected
schemas on the system database.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Managing databases” on page 29.|

Databases

This area displays the name of the currently selected server and database. Click Go
to select a different database. If the database is not shown in the list, click Add /
remove database to configure it.

Select one or more schemas to back up

This table displays a list of all schemas, the description of each schema, and the
last time it was backed up. Select one or more schemas by clicking the box in the
Select column of the table. Click OK to back up the selected schemas.

Where to store backup

Use this area to specify the backup location. You can view and select the backup
folder location by clicking Browse. The Location value defaults to the value
specified for the previous backup of the selected database.

Portlet fields, buttons, and links

The purpose, default value (if applicable) and action for the fields, buttons, and
links used by this portlet are as follows:
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Select Click to select a database schema for backup.

Schema
This is the name of the database schema.

Description
This is an extended description of the database schema.

Last backed up
This is the date and time of the most recent backup for this database
schema.

Location
This is the location for storing the backup. The first time a backup is
performed to a directory or tape, this field is blank. Specify the location b
either entering it or clicking Browse to select the location (see
backup location” on page 55). Subsequent backups use the previously
selected location.

Browse
Click to view the file system and select the backup location for storing the
backup.

OK  Click to perform the backup.

Cancel
Click to return without performing the backup.

Backup (Windows/Linux): Use this portlet to perform a one-step backup of the
selected database.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Managing databases” on page 29.|

Where to store backup

Use this area to specify the backup location. You can view and select the backup
folder location by clicking Browse. For a Tivoli Storage Manager (TSM) backup,
select the Number of sessions to be created between the DB2 instance and TSM.
The default is 1. The Location field default is the value from the previous backup
of the selected database.

Note: To configure for TSM use with IDS, refer to
[http:/ /publib.boulder.ibm.com /infocenter /ids9help /index.jsp|

Restriction: The typical backup of an Informix Dynamic Server Express database is
done using the ONTAPE and STDIO (standard input/output)
capability. If you restore a database from the file system, you must use
ONTAPE and STDIO. Refer to the "Restoring from Standard Input”
section of the IBM Informix Backup and Restore Guide for further
information on restoration of databases.

Type of backup to perform

This area is displayed only if the DB2 or IDS server is configured for online
backup; Online is the default option. Select Offline to override the default.


http://publib.boulder.ibm.com/infocenter/ids9help/index.jsp

Portlet fields, buttons and links

The purpose, default value (if applicable) and/or action for the fields, buttons and
links used by this portlet are:

Directory or tape
Click to back up the database to a directory or tape. This option is selected
by default.

Location
This is the location for storing the backup. The first time a backup is
performed to a directory or tape, this field is blank. Specify the location b
either entering it or clicking Browse to select the location (see
backup location”). Subsequent backups use the previously selected
location.

Browse
Click to view the file system and select the backup location for storing the
backup.

TSM  Click to choose the Tivoli Storage Manager.

Number of sessions
If the database is to be backed up to TSM, select TSM and choose the
number of sessions to use. The default is 1.

Online
If the database is enabled for online backup, this button is visible and
selected. Click Online for an online backup.

Offline
If the database is enabled for online backup, this button is visible. Click
Offline for an offline backup.

OK  Click to perform the backup.
Cancel

Click to return without performing the backup.

Browse for backup location: Use this portlet to locate the directory to use for
database backup on a server.

Note: You can also access the InfoCenter topics for this part of the console; see
[‘Managing databases” on page 29.|

To specify a backup location, select the directory for the backup. If necessary, you
can expand a node to show its subdirectories by clicking the blue box next to the
node name.

Click the directory name to select the directory.
Click Cancel to return without selecting a directory.
Portlet fields, buttons, and links

The purpose, default value (if applicable) and action for the fields, buttons, and
links used by this portlet are as follows:

Directory tree
This is the hierarchical display of directories on the selected server.

OK  Click to select the directory and return to the Logs and trace portlet.
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Cancel
Click to return without selecting a directory.

Status - database: Use this portlet to view the current operational status of the
selected database. In addition, you can start and stop a selected database, perform
a one-step backup, and check alerts.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Managing databases” on page 29|

The name of the selected database is shown at the top of the portlet.
Properties

This area displays these database properties:
* Operational state

* Last backup date

* Alert state

If the database is stopped, you can start it by clicking Start.
Note: This does not apply to iSeries.

If the database is started, you can stop it by clicking Stop and then clicking OK on
the resulting confirmation dialog. If no error message is displayed on the stop
request usually means the stop was successful.

Note: The list of databases to be stopped includes all databases on the same server
instance. All users and applications must be disconnected from the database
before you can stop the database. The default is to not force users to
disconnect. When the database is stopped, its operational state is
Unavailable because it is not possible to connect to the database. To restart
the database, click the Unavailable link.

Click Analyze logs to troubleshoot using the log files.
Missing or incorrect user ID or password

This dialog is shown when the authenticating identification is incorrect. Enter the
correct User ID and Password, and then click OK.

Confirm Stop

This dialog appears if you click Stop. This portlet displays all of the databases that

will be stopped. If any applications or users are connected to any of these

databases, the stop will fail.

Note: You can disconnect all users and applications from the database by clicking
Disconnect all users and applications. Use this option with caution, as it
might cause errors for multiple users.

Portlet fields, buttons, and links

The purpose, default value (if applicable) and action for the fields, buttons, and
links used by this portlet are as follows:



Operational state
This shows whether the selected database is currently started or stopped
and contains a link to change the state of the database.

Last Backup
This is the date and time that the selected database was last backed up.
Click Backup to access to the Backup portlet.

Alert state
This indicates the alert state and general health of the selected database.
Click Health to open the Health portlet for more detailed information.

Restriction: This option is not available for iSeries or Informix Dynamic
Server Express.

Backup
Click to back up the selected database.

Note: This option is not available on iSeries.

Backup Schemas
Click to back up specific schemas on the selected iSeries system database.

Health
Click to view all alarm, warning, and attention alerts for the selected
database.

Restriction: This option is not available for iSeries or Informix Dynamic
Server Express.

Refresh
Click to update the status information for the databases.

Alerts: This portlet displays a table summarizing the number of alarm, warning,
and attention alerts for each database. If the columns for a specific row are blank,
then alert information is not available for that database.

Note: You can also access the InfoCenter topics for this part of the console; see
[‘Managing databases” on page 29.|

Restriction:

On Windows and Linux, a health monitoring must be started for the database
instance. On Informix Dynamic Server Express and iSeries, health monitoring is
not available.

Portlet fields, buttons and links
The purpose, default value (if applicable) and/or action for the fields, buttons and

links used by this portlet are:

Database
This is the actual name of the database on the server.

Server This is the name for the server where the database resides.
Alarm This is the number of alarm-level events recorded for the database.

Warning
This is the number of warning-level events recorded for the database.
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Attention
This is the number of attention-level events recorded for the database.

Refresh
Click to refresh the status information for the databases.

Database health: This portlet displays a table summarizing the alarm, warning, and
attention alerts for each database. If the columns for a specific row are blank, alert
information is not available for that database.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Managing databases” on page 29|

Restriction: On Windows and Linux, you must start health monitoring for the
database instance. On Informix Dynamic Server Express and iSeries,
health monitoring is not available.

Portlet fields, buttons, and links

The purpose, default value (if applicable) and action for the fields, buttons, and
links used by this portlet are as follows:

Alert state
This is the level of alert, for example ALARM, that is currently associated
with the database. Click the name of the alert state for recommendations as
to what you should do.

Health indicator
This is the type of measurement that was used to determine the alert state.

Value This is the specific measurement for the associated health indicator.

Object name
This is the name of the database.

Timestamp
This is the date and time when the database alert event occurred.

Refresh
Click to update of the status of all databases in the table.

Recommendations: Use this portlet to view detailed information and
recommendations for a specific alert associated with the database whose name is
shown at the top of the portlet. You can review the recommended actions to
determine how to handle the alert. When you have finished, click Done.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Managing databases” on page 29 |

Portlet fields, buttons, and links

The purpose, default value (if applicable) and action for the fields, buttons, and
links used by this portlet are as follows:

Alert state
This is the level of alert, for example ALARM, currently associated with
the database.

Health indicator
This is the type of measurement that was used to determine the alert state.



Value This is the specific measurement for the associated health indicator.

Timestamp
This is the date and time when the database alert event occurred.

Additional Information
This area contains any additional information available for the selected
alert.

Recommended Action
This area contains any recommended actions for the selected alert.

Done Click to close the portlet.

IBM HTTP Server administration
IBM HTTP Server administration

With this component of the console you can administer one or more instances of a
Web server.

Select servers: This portlet allows you to select and work with a server.

Note: You can also access the InfoCenter topics for this part of the console; see
[Managing Web servers|

The Web servers area displays the name of the server containing an instance of the
IBM HTTP Server with the currently selected server displayed. When you
configure a server, that server is added to the list.

To display another server, select it from the list and click Go. If the server is not
shown in the list, you must first configure it by clicking Configure servers. Click
Add / remove servers to manually define a new server to configure.

Note: You should usually use the Configure console task to configure servers into
the console. Use this task if the configure task was not successful.

Status - Web server: With this portlet you can view the current status of all
instances of the selected IBM HTTP Server. In addition, you can start and stop a
selected IBM HTTP Server instance.

Note: You can also access the InfoCenter topics for this part of the console; see
[Managing Web servers|

The name of the IBM HTTP Server that is currently selected is shown at the top of
the portlet.

Status

This table displays the current status of all running instances of the selected IBM
HTTP Server. The instance name, along with the operational state of that instance
is shown. You can change the server state by selecting a server in the table, and
clicking either Start or Stop. Click Refresh table to update the display with the
current server state.

Click Analyze logs to troubleshoot using the log files.
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Portlet fields, buttons, and links

The purpose, default value (if applicable), and action for the fields, buttons, and
links used by this portlet are as follows:

Select Click this to select a row for acting on.

Server instance
This column contains the names of the running instances of the IBM HTTP
Server that is currently selected.

Operational state
This is the operational state of the component, which might be started,
stopped, unavailable, or unknown. Started indicates that the component is
running. Stopped indicates that the component is not running. Unknown
indicates that the server on which the component is running cannot be
reached.

Start  Click Start to start the selected component if the server is currently
stopped.

Stop  Click Stop to start the selected component if the server is currently started.
Refresh table
Click to refresh the table.

Add/remove server: Use this portlet to manage the list of Web servers available
for viewing within the console. You can add new servers, edit or delete existing
servers, and test the connections to the servers.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Managing Web servers” on page 36.

Add a server

To add a new server, follow these steps:

1. Enter the Fully qualified host name for the new server.

2. Enter the Agent port number for the Web administration server.

3. Optionally, enter a short Comment or description of the new server.
4. Click Add to list.

Note: Click Configure server to add or update the console configuration for the
server.

Current servers

This is a list of currently defined servers. You can edit, remove, or test the
connection to a server by selecting the server and clicking the appropriate button.

Note: If the table contains a large number of items, you can use filtering and
sorting capabilities to manage the task more easily; see [‘Starting and setting]
[up the console” on page 21| for a description.

Portlet fields, buttons, and links

The purpose, default value (if applicable) and action for the fields, buttons, and
links used by this portlet are as follows:

Server This is the name for the server.



Agent port
This is the port number for the console agent for the WebSphere
Application Server - Express server. The value of this port is configured at
install time and defaults to 7044.

Comment
This is an optional comment describing the server.

Add Click to add the server to the list of servers.

Current servers
This is a list of the currently configured servers.

Edit  Click to edit the selected server. You can change any settings and then click
Apply to save the changes.

Apply Click to save the changes made to the server.

Cancel
Click to cancel the changes made to the server.

Remove
Click to remove the selected server from the console configuration.

Test connection
Click to display the portlet to test the connection with the selected server.

Done Click to close this portlet.
Test connection: Use this portlet to test the connection to a server.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Managing Web servers” on page 36.

You can test the connection to any of the servers included in the list. The table
contains the names of all the servers to be tested. You can also enter the
administrator user ID and password. If you previously had authenticated access to
the server, the user ID and password fields are filled in.

Note: Click User ID and password help if you are unsure about which user ID
and password combination to supply.

Enter the user ID and password for the server, and then click Test. The server is
tested and the result of the test is shown in the Result column. If an error occurs,
or the test fails, a message is shown.

The user ID and password is stored for a server that connects successfully.
Subsequent communication with this server uses these stored values.

Portlet fields, buttons, and links
The purpose, default value (if applicable) and action for the fields, buttons, and
links used by this portlet are as follows:

Server This is the name of the server.

User ID
This is the administrator user ID for the server.

Password
This is the administrator password for the server.

Result This is the result of the test.
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Test Click to test the server.

Close Click to close the Test connection portlet.

Troubleshooting: For more information about errors that occur when attempting to
connect to a component, refer to the troubleshooting information for the failing
component. See [“Troubleshooting IBM HTTP Server” on page 73 for more
information.

Logs and trace: Use this portlet to set trace levels for the Web server.

Note: You can also access the InfoCenter topics for this part of the console; see
[Managing Web servers|

To set trace levels, select a Server instance and then click Select for the
appropriate row in the List of Web server instances. This displays the Error log
information for the selected instance.

Enter the fully qualified file name of the Log file, or click Browse to locate the file.

Select one of these entries from the Minimal message level list:
* Error conditions

* Warning conditions

* Debug-level messages

Choose whether to do reverse lookups on the host names of clients that access the
server, by clicking the appropriate Host name lookups option. You can click On,
Off, or Double).

Click Apply to save the changes.
Portlet fields, buttons, and links

The purpose, default value (if applicable) and action for the fields, buttons, and
links used by this portlet are as follows:

Log file
Enter the fully qualified file name of the error log in this field. Optionally,
you can specify a file name that is relative to the IBM HTTP Server root.

Browse
Click to browse the remote system and select a file.

Minimal message level
Choose the level of error messages to log:

Error conditions
This turns error conditions for the Web server on or off. This level
is enabled by default.

Warning conditions
This turns warning conditions for the Web server on or off. This
level is enabled by default.

Debug-level messages
This turns debug-level messages for the Web server on or off.



Host name lookups
Choose whether to do reverse lookups on the host names of clients that
access the server, by clicking the appropriate Host name lookups option.
You can click On, Off, or Double).

Apply Click to save the new settings.
Browse for log file
Use this portlet to locate the log file on a remote Web server.

To locate a log file:

1. Locate the folder that contains the log file. If necessary, open the folder to show
its subfolders by clicking the blue box next to the folder name.

2. Click the folder name to display a list of the files in that folder.
Click Select next to the File name.

w

4. Click OK to select the file and return to the Logs and trace portlet or click
Cancel to return without selecting a file.

Portlet fields, buttons, and links
The purpose, default value (if applicable) and action for the fields, buttons, and

links used by this portlet are as follows:

[No label]
This is the hierarchical display of folders on the selected server instance.

Select Click to select the file name.

File name
These are the names of the files in the selected folder.

OK  Click to select the file and return to the Logs and trace portlet.

Cancel
Click to return without selecting a file.

Browse for log file: Use this portlet to locate the log file on a remote Web server.

Note: You can also access the InfoCenter topics for this part of the console; see
[‘Managing Web servers” on page 36.

To locate a log file:

1. Locate the folder that contains the log file. If necessary, expand the folder to
show its subfolders by clicking the blue box next to the folder name.

2. Click the folder name to display a list of the files in that folder.
Click Select next to the File name.

w

4. Click OK to select the file and return to the Logs and trace portlet or click
Cancel to return without selecting a file.

Portlet fields, buttons, and links

The purpose, default value (if applicable) and action for the fields, buttons, and
links used by this portlet are as follows:

N/A  This is the hierarchical display of folders on the selected server instance.

Select Click to select the file name.
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File name
These are the names of the files in the selected folder.

OK  Click to select the file and return to the Logs and trace portlet.

Cancel
Click to return without selecting a file.

IBM WebSphere Application Server - Express administration

InfoCenter

WebSphere Application Server - Express administration
With this component of the console you can administer a WebSphere Application
Server - Express server.

Select servers: Use this portlet to select and work with a server.

Note: You can also access the InfoCenter topics for this part of the console; see
[Managing application servers]

The Application servers area displays the name of the WebSphere Application
Server - Express server with the currently selected server displayed.

To display another server, select it from the list and click Go. If the server is not
shown in the list, you must first configure it by clicking Configure servers. Click
Add / remove servers to manually define a new server to configure.

Note: You should usually use the Configure console task to configure servers into
the console. Use this task if the configure task was not successful.

Application server console task: This portlet displays the WebSphere Application
Server — Express console task for the selected server. The information is the same
as you would see on the WebSphere Application Server — Express console. See
[“Using the navigation frame” on page 22 for the types of selections that can be
displayed in this portlet.

You can select any WebSphere Application Server — Express administrative task
from the navigation pane, and it is displayed in this portlet. Refer to the
WebSphere Application Server — Express InfoCenter for details of the actions you
might take. You can also access the WebSphere Application Server — Express online
help by clicking the help links in the portlet.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Managing application servers” on page 33

Note: If you received a message indicting that a different profile was selected for
the same server, click OK to proceed with the new profile or click Cancel to
continue with the old profile.

You might have trouble running this task if the WebSphere Application Server
version is unknown or out of date. The console attempts to determine the version
information from the console agent on the host computer. If the console agent is
unable to determine the version number, a panel is displayed that asks for this
information. The version information can also be updated using the Configure
components task. The WebSphere Application Server version can be found in the
WAS.product file. The file is found under each installation in the following
location:

<WebSphere_Application_Server_Install_Path>/AppServer/properties/version/WAS.product



Where <WebSphere_Application_Server_Install_Path> is the installation directory
for WebSphere Application Server.

You need to provide the text between the <version> tags.
Status - Application server: With this portlet you can view the current status of
the selected WebSphere Application Server - Express server. In addition, you can

start and stop a selected server.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Managing application servers” on page 33)

The name of the currently selected server is shown at the top of the portlet.
Servers

This table displays the current status of all selected servers. The name, along with
the operational state of that server, is shown. You can change the server state by
clicking either Start or Stop. Click Refresh table to update the display with the
current server state.

Click Analyze logs to troubleshoot using the log files.
Portlet fields, buttons, and links
The purpose, default value (if applicable), and action for the fields, buttons, and

links used by this portlet are as follows:

Server information
Click to retrieve information for the selected server.

Support
Click to retrieve support information for the selected server.

Select Click this to select a row for acting on.

Server Instance
This is the host name of the server.

Operational state
This is the current state for the server (started or stopped).

Start  Click to start the selected server, if the server is currently stopped.
Stop  Click to stop the selected server, if the server is currently started.
Refresh table

Click to refresh the table.

Add/remove server: Use this portlet to manage the list of WebSphere Application
Server - Express servers available for viewing within the console. You can add new
servers, edit or delete existing servers, and test the connections to the servers.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Managing application servers” on page 33

Add a server

To add a new server:

1. Enter the Fully qualified host name for the new server.
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2. Enter the Port number for the WebSphere Application Server - Express
administrative console. The default port value for the administration console is
9060.

3. Enter the console Agent port number for the server. The value of this port is
configured at install time and defaults to 7044.

4. Optionally, enter a short Comment or description of the new server.
5. Click Add to list.

Note: Click Configure server to add or update the console configuration for the
server.

Current servers

This contains the list of currently defined servers. You can edit, remove, or test the
connection to a server by selecting the server from the list and clicking the
appropriate button.

Portlet fields, buttons, and links
The purpose, default value (if applicable) and action for the fields, buttons, and
links used by this portlet are as follows:

Server This is the name for the server.

Port  This is the port number for the WebSphere Application Server - Express
administration server. The default port value for the administration console
is 9060.

Agent port
This is the port number for the console agent for the WebSphere
Application Server - Express server. The value of this port is configured at
install time and defaults to 7044.

Comment
This is an optional comment describing the server.

Add Click to add the server to the list of servers.

Current servers
This is a list of the currently configured servers.

Edit  Click to edit the selected server. You can change any settings and then click
Apply to save the changes.

Apply Click to save the changes made to the server.

Cancel
Clicking to cancel the changes made to the server.

Remove
Click to remove the selected server from the console configuration.

Test connection
Click to display the portlet to test the connection with the selected server.

Done Click to close this portlet.
Test connection: Use this portlet to test the connection to a server.

Note: You can also access the InfoCenter topics for this part of the console; see
[“Managing application servers” on page 33




You can test the connection to any of the servers included in the list. The table
contains the names of all the server to be tested. You can also enter the
administrator user ID and password. If you previously had authenticated access to
the server, the user ID and password fields are filled in.

Note: Click User ID and password help if you are unsure about which user ID
and password combination to supply.

Enter the User ID and Password for the server, and then click Test. The server is
tested and the result of the test is shown in the Result column. If an error occurs,
or the test fails, a message is shown.

The user ID and password is stored for a server that connects successfully.
Subsequent communication with this server uses these stored values.

Portlet fields, buttons, and links
The purpose, default value (if applicable) and action for the fields, buttons, and
links used by this portlet are as follows:

Server This is the name of the server.

User ID
This is the administrator user ID for the server.

Password
This is the administrator password for the server.

Result This is the result of the test.

Test  Click to test the server.

Close Click to close the Test connection portlet.

Troubleshooting: For more information about errors that occur when attempting to
connect to a component, refer to the troubleshooting information for the failing

component. See [“Troubleshooting WebSphere Application Server — Express” on|
for more information.
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Defining custom solutions using XML files

You can use XML files to predefine custom solutions. You can create these files in
Express Runtime as part of application development and deployment, or you can
create them directly on the appropriate host computers. Then the configure custom
solutions task uses the files to configure the console.

A custom solution can include middleware components (databases, application
servers, or Web servers) located on one or more host computers.

To define such a solution with XML files, you must create an XML file for each
affected host computer, defining the same custom solution. Each custom solution
has a unique ID (uid); this ID would be the same value for the custom solution
definitions on each of the hosts having components belonging to the solution. You
can create the XML files using the provided sample file
(SampleCustomSolution.sample) as a template.

There is also an optional associated properties file for the XML file, which can also
be created using the sample template provided
(SampleCustomSolutionProperties.sample); this file is used to define text values
requiring translation into multiple languages. The text values requiring translation
are coded in the XML file with a percent character prefix (%). The properties files
are then created for each language requiring translation; they should be named the
same as the corresponding XML file, but with a suffix indicating the language (for
example, MySolution_fr.properties); the language codes are those used for Java.
Refer to |http:/ /java.sun.com/i2se/1.4.2 /docs/api/java/util /Locale.html| for the
specific codes.

Note: The version of the properties file without a language-specific suffix should
be provided; it should contain the default values for each of the items. If a
default value is not provided, the tag ID is used.

The completed XML and properties files are stored in the customSolutions
subfolder of the installation location for the console agent on each host computer.

Note: The XML and properties files should be saved using Unicode, to facilitate
translation.

The XML tags contained in the file are:

Table 1. Custom solution definition XML file

Tag Description

customsolutions This is the overall container tag for defining one or more custom
solutions for a given host.

customsolution This is the container tag for defining one custom solution.

uid This is the unique ID for a custom solution. Each custom solution

must have its own ID. This ID is used once in each file on every
host containing components in the custom solution. The ID serves
to logically link together the components on multiple hosts that are
part of the solution.
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Table 1. Custom solution definition XML file (continued)

Tag

Description

name

This is the name you assign to the solution. The text in this field
can be translated.

comment

This a descriptive phrase to help in managing the solution. The text
in this field can be translated.

database

This is a container tag for defining a database component of a
custom solution.

M type

This is the type of database (DB2 or IDS).

¢ instancename

This is the name of the DB2 instance. (This is not required for IDS.)

¢ servername

This is the name of the IDS server. (This is not required for DB2.)

¢ databasename

This is the name of the database.

applicationserver

This is the container tag for defining an application server
component of a solution.

* type

This is the type of server (WAS).

* profilename

This is the name of the profile used for accessing the WebSphere
Application Server — Express server.

webserver

This is the container tag for defining a Web server component of a
solution.

* type

This is the type of server (IHS).

¢ servername

This is the name of the IHS server. Include the port number used to
access the server (for example, myServer:80).

Note: The values for middleware components are abbreviations:

DB2 DB2 UDB Express

IDS  Informix Dynamic Server Express

IHS IBM HTTP Server

WAS  WebSphere Application Server — Express

Troubleshooting

This section provides guidance for resolving problems that arise with the Express
Runtime console. General guidance is provided, as well as specific topics for
resolving problems with console modules and management extensions.
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Viewing product version information

To properly troubleshoot and report problems, you might need specific product
version information. You access this information differently depending on the
particular problem and portion of the product you are using. You access this
information differently for each part of the product:

Express Runtime

Select Start > Programs > Express Runtime 2.1 > About.

Express Runtime developer
From within Express Runtime developer, select Help > About Express
Runtime developer. Click the icon at the far right of the dialog to view
both version and build information.

InfoCenter




Deployment wizard
From within the deployment wizard, select Help > About. The window
displays the build ID for the deployment wizard and JVM version
information.

Express Runtime console
The Welcome page provides the version information for Integrated
Solutions Console and the Express Runtime console.

Integrated Solutions Console

This section provides some general information to assist you in dealing with the
Integrated Solutions Console. Refer to the Integrated Solutions Console InfoCenter
for more detail.

Starting and stopping Integrated Solutions Console

When an installation is successful, the Integrated Solutions Console starts
automatically. If you need to stop or start the Integrated Solutions Console
manually to resolve a problem, you can use the following batch files on Windows
systems:

To start Integrated Solutions Console:
C:\Program Files\IBM\ConsoleIR21\PortalServer\bin\startISC.bat
<userID> <password>, where <userID> and <password> are those assigned
during the installation of the console.

To stop Integrated Solutions Console:
C:\Program Files\IBM\ConsoleIR21\PortalServer\bin\stopISC.bat
<userID> <password>, where <userID> and <password> are those assigned
during the installation of the console.

Alternatively, on Windows computers, you can use the Services panel to start or
stop the Integrated Solutions Console. The service name is IBM WebSphere
Application Server V5 - ISC_Portal.

On Linux systems, use the following shell scripts:

To start Integrated Solutions Console:
C:\Program Files\IBM\ConsoleIR21\PortalServer\bin\startISC.sh
<userID> <password>, where <userID> and <password> are those assigned
during the installation of the console.

To stop Integrated Solutions Console:
C:\Program Files\IBM\ConsoleIR21\PortalServer\bin\stopISC.sh
<userID> <password>, where <userID> and <password> are those assigned
during the installation of the console.

Connecting to the Integrated Solutions Console

To connect to the Integrated Solutions Console, open a Web browser and point to
the following URL:

http://host name:8421/ibm/console/
Where host name is the fully-qualified host name of the server where Integrated

Solutions Console is installed, and 8421 is the default HTTP port for Integrated
Solutions Console.
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If you did not accept the default port, and you cannot remember the port you
chose, open server.xml, located in the following folder in the location where the
console is installed (typically C:\Program Files\IBM\ConsoleIR21):

AppServer\config\cells\ DefaultNode\nodes\ DefaultNode\servers\ISC_Portal\

The port attribute of the transports element defines the port that Integrated
Solutions Console uses. Locate the line in the file that begins with <transports
xmi:type="aplicationserver.webcontainer:HTTPTransport". The following line
should contain an address tag; this has the port value.

Log files

Runtime log files for the Integrated Solutions Console contain information that you
might need to supply to the IBM Support Center if there is a problem with the
Express Runtime console. If you accepted the default installation directory you can
find the runtime log files in the following location:

c:\Program Files\IBM\ConsoleIR21\PortalServer\log
If you did not accept the default installation directory, look in the

PortalServer\log subdirectory of the directory where you installed the Express
Runtime console.

Resolving connectivity problems

InfoCenter

If you unexpectedly get reports indicating that the operational state of a
component such as a database or a server is unknown or unavailable, it may be
because the console agent on the server is not connecting the console to the
management extension. To check that the console agent is operating, click the
Troubleshooting > Console agent > Test connection task in the navigation pane.
See [Using console agents| for details.

Note: If you reinstall a middleware component, you must restart the console agent
to ensure a connection to the console.

To restart the Express Runtime console on Windows computers:
Click Start > Settings > Control Panel.

Double-click Administrative Tools.

Double-click Services.

Select Express Runtime console Agent.

Click Restart.

Close the Windows Services control panel.

o0k~ wN =

To restart the Express Runtime console agent on Linux computers:
1. Open a terminal window.

2. Change directories to the Express Runtime console installation location. By
default, the installation location is /opt/IBM/IRUExt/Console Agent/.

3. Run ./stopService.sh.
4. Run ./startService.sh.
5. Close the terminal window.
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Runtime log files for the console agent contain information you might need to
supply to the IBM Support Center if there is a problem with the Express Runtime
console. If you accepted the default installation directory you can find the log files
in the following location:

¢ C:\Program Files\IBM\IRUExt\Console Agent for Windows
* /opt/IBM/IRUExt/Console Agent for Linux

User ID and password for managing middleware components

All of the middleware components require authentication before you can perform
administrative tasks. You might receive an error message indicating that you have
not supplied a valid user ID and password combination.

See the [“User IDs and passwords” on page 38| help for details.

Troubleshooting databases

Troubleshooting DB2 UDB Express

If you are unable to retrieve information from DB2 UDB Express:

* Ensure that the user ID logging on to DB2 has Execute permission for the
database. Use the DB2 Control Center to configure permissions.

* Ensure that the database is configured to monitor health indicators. The database
must have a tablespace of at least 8MB for sorting. Refer to the DB2
documentation for more information.

The console agent manages DB2 UDB Express activities on Windows or Linux
computers. The console agent needs to be running for DB2 management extensions
to function properly.

Troubleshooting Informix Dynamic Server Express

If you are unable to retrieve information from Informix Dynamic Server Express:

* Ensure that the user ID logging on to Informix Dynamic Server Express has the
appropriate permission for the database.

* Ensure that the database is configured to monitor health indicators. Refer to the
Informix Dynamic Server Express documentation for more information.

The console agent manages DB2 UDB Express activities on Windows or Linux
computers. The console agent needs to be running for Informix Dynamic Server
Express management extensions to function properly.

Troubleshooting IBM HTTP Server

If there is a problem connecting to IBM HTTP Server, use the Test connection
portlet (see [Testing the connection to a server) to determine which component is
failing

Location of configuration files

If the configuration files have been placed in a directory other than the default,
update the console agent to add this directory.

Troubleshooting WebSphere Application Server — Express

Connecting to WebSphere Application Server — Express
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If there is a problem connecting to WebSphere Application Server — Express, IBM
HTTP Serveruse the Test connection portlet (see [[esting the connection to a server)
to determine which component is failing

The most common problems that cause connection errors for WebSphere
Application Server — Express are that the server host name is not fully-qualified, or
that the port number that is specified is not the HTTP port. The HTTP port, but
not the HTTPS port is required. The fully-qualified host name much be used in
both the URL for the Integrated Solutions Console and in the host name for
WebSphere Application Server — Express. Both must share the same domain. If
they do not, a cross domain cookie security issue occurs.

WebSphere Application Server — Express - management
extensions

The management extensions for WebSphere Application Server — Express are
changes to the WebSphere System Console adminconsole Web application to help
the tasks be hosted in the Integrated Solutions Console, and an agent that helps the
application server start and stop.

All modified files are backed up prior to modification and all modifications are
removed if the WebSphere Application Server - Express management extensions
are uninstalled.

Problem analysis and reporting

InfoCenter

Reporting Problems

The IBM Virtual Innovation Center’ (http://www.ibm.com/partnerworld/vic)
provides a broad range of technical support services to address problems. The
intent of the Virtual Innovation Center team is to provide the participants with the
support and education that they need. To achieve a level of excellence that exceeds
your expectations, the Virtual Innovation Center provides:

* Rapid response to your requests

* Fast relief to high-impact problems

* Timely problem resolution

* High quality fixes and information

* Up-to-date service information and installation information

e The latest resources that are available
Diagnosing a Problem

In many cases, you might wait until an error happens two or three times before
actually taking the time to diagnose it. You might wait for any number of reasons.
When you decide to diagnose a system problem, follow these steps:

* When the problem occurs, collect the symptom data and determine what type of
problem it is.

* Once you determine the type of problem, determine if the problem is a product
problem or a user problem.

* Build a search argument from the data collected.

* Report the problem to IBM, using the search argument as a method to determine
if the problem is a duplicate.
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The following topics help you understand what information to gather in order to
diagnose the problem.

Selecting the Proper Form to Submit to the Virtual Innovation Center

Below is a sample of the types of information that should be included by request
or report type.

Select the proper form Your first selection is one of the most important. It
indicates the type of submission you want to make. There are three forms to
choose from:

* Participant Issue

Participation Issue reports can be submitted to reflect problems or issues in your
interaction with the Virtual Innovation Center Community site. These types of
issues can be about accessing educational material to accessing resources.

Information for this type of report includes component, browser and version,
error number and message (if applicable), and the specific problem you are
experiencing.

* Product Issue

Product Issue reports can be submitted for either Express Runtime for OEM,
WebSphere Application Server - Express or DB2 UDB - Express. These reports
indicate specific problems with the product that are considered to be a suspected
defect (for example, the product is not performing to specifications).

Information for this type of report includes error number and message, product
component (for example, for WebSphere Application Server - Express, the
problem might exist in the development environment or the deployment
environment), and steps required to re-create the problem.

* Request for Porting Assistance

The Request for Porting Assistance submission is only available to companies
and participants that have requested such assistance and have been approved by
IBM. The ability to access this feature is part of the registration process.

The Request for Porting Assistance submission is designed as the mechanism by
which advanced help is provided to companies utilizing the product code to
develop or port applications. Information for this type of request includes
product, component, company project, and the specific assistance that is
required.

Types of Information to Gather Before Submitting a Problem to the Virtual
Innovation Center

In order to efficiently and quickly resolve problems, provide as much information
as possible to the IBM Virtual Innovation Center team. This includes providing
steps for re-creating the problem, as well as explanations of errors, lack of action
you experienced, or unexpected actions that occurred.

Fill out the form

Once you have selected the form to use, you must provide information specific to
that form. The information that you provide forms the basis of the resolution
process for your submission and must be as accurate and complete as possible.

¢ Product The product for which you are submitting the problem or request.
Depending on the type of submission, your choices vary. For Participant Issues,
the type of system is the product.
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Version The version of the product. The version choices change to represent the
proper list when you make your product selection.

Component The component of the product currently selected. The choices for
component change to represent the proper list when you make your product
selection.

Browser The browser that you were using when the issue occurred.

Hint: This information is important, especially for Participation Issues, because
some errors only occur in specific browsers but function properly in others.

Browser version The version of the browser. The choices change to represent the
proper list when you make your browser selection.

Operating System The type of operating system you are using. Knowing the
operating system assists in the process of re-creating the problem. It might also
be used to quickly determine if the problem you are reporting is known to be an
issue with your particular operating system. Ensure that you also include any
service pack revisions or upgrades applied to your operating system.

Re-creatable The determination whether the issue that you are experiencing
re-creatable. In other words, does the problem occur each time you attempt a
certain action, or did it occur a single time. Issues that are reported should be
recurring, re-creatable problems.

If the problem seems to have gone away or fixed itself, do not submit it as an
issue. Report sporadic issues through the e-Tutors. You can also use e-mail,
which is available in the Virtual Innovation Center Site, under the Help Options
or e-Support features.

Error Number The error number that is displayed when the error occurs. For
example, when you navigate to a page and get a 'Page cannot be displayed’
message, you also see "HTTP 404" displayed either at the top or bottom of the
page.

Error Message The error message that is displayed. If the message is too large to
include within the field, paste the message into a text or document file. Then
upload it to the IBM Virtual Innovation Center team. See the file attachment
fields at the bottom of the data entry panel.

Steps to Re-create The steps that were followed to cause this problem. If the
steps that you need to include exceed the size of the entry field, paste the
message into a text or document file. Then upload it to the IBM Virtual
Innovation Center team. See the file attachment fields at the bottom of the data
entry panel.

Unexpected actions The events that result in a significantly unusual occurrence,
for example, a link that previously brought you to one location now brings you
to a completely different location, or no longer works.

Other Information Any additional information that is relevant in order for IBM
to help resolve the problem. If the information that you need to include exceeds
the size of the entry field, paste the message into a text or document file. Then
upload it to the IBM Virtual Innovation Center team. See the file attachment
fields at the bottom of the data entry panel.

File Attachment/Uploading Files Fields that allow you to attach any necessary
files to your report submission.
Tip: Before attaching any files, use a compression utility to compress all of your

files into one *.zip file. Click Browse to select your *.zip file. Once selected, click
Submit.

Support for End-User Customer Defects
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The IBM Support Center offers service during normal business hours. Two
methods of reporting Express Runtime for OEM End-User customer defects are:

* Contact IBM software support at (http://www.ibm.com/software/support)

* Contact your local IBM Support Center by telephone, using the number that was
provided to you in the original "Welcome” letter you received after completing
the original equipment manufacturer (OEM)/ISV Agreement process for the IBM
Express Runtime for OEM software product.

When contacting the IBM Support Center, you will be asked to provide the
following information:

* IBM Customer Number
* Telephone number and caller name
¢ Company name

* Name of product for which you need support (for example, the IBM Integrated
Runtime product). Although Express Runtime for OEM includes WebSphere(R)
Express, DB2(R) UDB Express and other components, specify the initial problem
report with Express Runtime for OEM as the product.

Before Contacting the IBM Support Center

Take the following steps before you contact the IBM Support Center. Gather
information about the problem, and have it on hand when you discuss the
problem with the IBM Support Center.

The checklist below (Problem Resolution Work Sheet, Appendix A) can help you

identify the problem.

1. Define the Problem: Use the checklist below, Problem Resolution Work Sheet
(Appendix A), to help you identify the problem and communicate the specifics
about the problem to the IBM Support Center.

APPENDIX A: Problem Identification Work sheet Complete this form before
calling Technical Support This form helps you identify problems and assists the
IBM Support Center in finding solutions.

¢ System Information
— What is the failing product?
— What is the version number and the release number?
— What machine model, operating system, and version are running?
* Problem Description
— What are the expected results?
— What statement or command is specified?
— What are the exact symptoms and syntax?
— What is happening? What is the message text and error number?
— Is anyone else experiencing the problem?
— Is this the first time this operation has been attempted?
— Is this the first time this problem has occurred?
* Environment
When did this activity work last?
What has changed since the activity last worked?

__ Hardware type/model __ Application

__ Operating system/version __ Level of usage
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— __ New product version/release __ Maintenance applied

* If the problem does not occur every time, under what conditions does the
problem not occur?

* Is there any other software running on the system which may be conflicting
with this product?

* Problem Isolation
— Identify the specific feature of the software causing the problem.

— Can you reproduce the problem? If so, provide a reproducible test case or
instructions on how to reproduce the error condition

Gather Background Information

To effectively and efficiently solve a problem, provide all of the relevant
information about the problem. Being able to answer the following questions
can help in resolving your software problem:

*  What levels of software were you running when the problem occurred?
Include all relevant products, for example, operating system as well as
related products.

* Has the problem happened before, or is this an isolated problem?
e What steps led to the failure?
¢ Can the problem be re-created? If so, what steps are required?

* Have any changes been made to the system? (Hardware, netware, or
software)

*  Were any messages or other diagnostic information produced? If yes, what
were they?

* It is often helpful to have a printout of the message numbers of any
messages received when you place the call for support.

* Define your technical question in specific terms and provide the version and
release level of the product or products in question.

Gather Relevant Diagnostic Information (if possible): It is often necessary that
the IBM Support Center analyzes specific diagnostic information, such as
storage dumps, traces, and so on, in order to resolve the problem. Gathering
this information is often the most critical step in resolving the problem.
Product-specific diagnostic documentation can be very helpful in identifying
what information is typically required to resolve problems. If you are unsure
about what documentation might be of use, The IBM Support Center is
available to provide you assistance and guidance. However, you must provide
information about your system and the failing component, and any other
information that is critical to resolving the problem. The IBM Support Center
can provide assistance in gathering the needed diagnostic information.

Reporting a Software Problem: IBM does not warrant that our products are
defect free; however IBM endeavors to fix them to work as designed. The IBM
Support Center is available to provide you assistance and guidance; however
you must provide information about your system and the failing component,
and any other information that is critical to resolving the problem.

Tasks you might need to complete to provide information include:
* Capturing documentation at the time of a failure

* Applying a trap or trace code to your system

¢ Formatting the output from the trap or trace

* sending documentation or trace information, in hardcopy or soft copy, to the
IBM Support Center.
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Occasionally, removal of installed fixes might be necessary in the process of
isolating problems. Fixing a problem might mean the installation of a later
release of the software, because some fixes cannot be retrofitted into earlier
code.

You need to be aware of your responsibilities when working with the IBM

Support Center, as stated in your OEM/ISV Agreement. If you do not have the
required skill or cannot complete the diagnostic tasks, you can engage a service
provider (for an additional fee) such as IBM Global Services (IGS) to assist you.

Problem Analysis and Problem Identification Tutorial Education

The Problem Determination Mastery Self-Study Series is a tutorial that is designed
for the following groups:

* Users that support applications in a database environment
* Users that develop applications in a database environment
* Users of WebSphere Application Server products.

This new tutorial was developed as a collaborative effort of IBM's leading technical
staff. The complimentary tutorial teaches you the following skills:

* To identify product issues
* To isolate product issues

* To resolve product issues

With these skills you can reduce the time it takes to resolve a problem, as well as
reduce your dependence on the IBM Support Center. Currently a mastery
examination is available for DB2 Universal Database(C) and WebSphere
Application Server.

* DB2 UDB Tutorial - (http:/ /www-306.ibm.com/software/data/support/pdm/)

* WebSphere Application Server Tutorial - (http://www-
3.ibm.com/software/webservers/appserv/express/support/pdt.html)

2 Symptom database
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You can analyze the console messages by using the log analyzer. See
llog analyzer” on page 29| for more information about this capability.

IRU05000 messages

This chapter lists the messages generated by the console. You can use the
information in this chapter to identify and resolve an error using the appropriate
recovery action. You can also use this information to understand where messages
are generated and logged.

The user responses for several messages suggest that you print the log file before
calling your service provider.

Message identifiers consist of a three-character message prefix followed by a
five-digit message number. Tokens, such as {0}, {1}, and so on, are used in many
messages. These tokens represent computer names, application names, files names,
or directory names. The appropriate value is substituted for the token when the
message is displayed.
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IRU05000

Failed: Incorrect user ID or password

Explanation:

An authentication failed due to either incorrect user ID or password.

User response:

Enter the correct user ID and password.

IRU05001

Failed: Select a resource before clicking Edit or Test connection.

Explanation:
A resource was not selected on which to perform the function.
User response:

Select a resource and relaunch the task.

IRU05002

Failed: Select only one resource before clicking Edit.
Explanation:

Multiple instances were selected to edit simultaneously.
User response:

Select one resource at a time.

IRU05003

Specify a server.

Explanation:

A valid server was not specified in order to perform the task.
User Response:

Provide a valid server.

IRU05004

InfoCenter

Specify a port.



Explanation:
A valid port number was not specified in order to perform the task.
User response:

Provide a valid port number.

IRU05005

Specify a console agent port.

Explanation:

A valid console agent port number was not specified in order to perform the task.

User response:

Provide a valid console agent port.

IRU05006

Could not connect to server.

Explanation:

The Express Runtime console could not connect to specified server.
User response:

Check the error logs and the troubleshooting section of the Express Runtime
Information Center to find more details on how to resolve this problem.

IRU05007

The requested function is not available for this resource.
Explanation:

You cannot perform this task using the selected resource.

User response:

Choose an appropriate task for the selected resource.

IRU05008

The specified component node is null.
Explanation:

This message is used only by the IBM Support Center.
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User response:

Provide the message output to the IBM Support Center representative.

IRU05009

Select at Teast one component from the table.
Explanation:

No component was selected from the table to perform the task.
User response:

Select at least one component in the table for the task.

IRU05010

Provide a title before clicking Add.
Explanation:

A title was not provided.

User response:

Provide a title before clicking add.

IRU05011

The requested action was canceled by the user.
Explanation:

The task was canceled before it could be completed.
User response:

Run the task again.

IRU05012

InfoCenter

Could not connect to the console agent.

Explanation:

The Express Runtime console could not connect to the console agent.
User response:

Consult the troubleshooting section of the Express Runtime console Information
Center to get details on how to solve this problem.



IRU05013
Could not find any instances for component {0}.
Explanation:

The Express Runtime console could not find any instances for the specified
component.

User response:

Consult the troubleshooting section in the Express Runtime Information Center for
details to solve this problem.

IRU05014
One or more thresholds were modified to ensure consistency.
Explanation:

The Express Runtime console had to modify one or more thresholds to maintain
consistency.

User response:

This is an informational message. No action is necessary.

IRU05016

The specified title, {0}, already exists. Select a different title.
Explanation:

A title was selected that already exists.

User response:

Select a new title.

IRU05017

The certificate verification for the following server, {0}, at agent port,
{1}, failed.

Explanation:
The certificate was not accepted by the server.
User response:

Ensure that you have updated your certificate.
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IRU05019

The user has been Tocked out of the agent.
Explanation:

An attempt was made to log in to the console agent too many times. As a security
measure, the agent has locked the user out for a specified amount of time.

User response:

Consult the troubleshooting section of the Express Runtime Information Center to
find more information on how to solve this problem.

IRU05020

One or more components were deleted while you were working with this group.
Explanation:

One of the components in a component group you are actively working with has
been removed.

User response:

Close the task and reopen it; the revised component list will not include the
component that caused the error.

IRU05021

The specified server information, {0}, already exists. Please verify your
server information.

Explanation:
You have specified a server which is already defined.
User response:

Specify a different server and perform the operation again.

IRU05022

InfoCenter

Error reading {0} from {1}.
Explanation:

This is an informational message.
User response:

No action is required.



IRU05023

Failed: User ID does not have sufficient authority to perform the requested

operation.

Explanation:

You are not authorized to perform the operation.
User response:

Log on with the proper authorization and perform the operation.

IRU05024
Could not connect to the following server, {0} at agent port, {1}.
Explanation:
This is an informational message.
User response:
No action is required.
IRU05030
Method entry
Explanation:
This message is used only by the IBM Support Center.
User response:
Provide the message output to the IBM Support Center representative.
IRU05031
Method exit
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05032

An exception has occurred: {0}.
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05033
Error creating/invoking UserTaskManager.
Explanation:
There was an error launching the portlet.
User response:

Provide the message output to the IBM Support Center representative.

IRU05034

Cannot set portlet help URL Tink because one of the following is null:
server is {0}; helpport is {1}; path to file is {2}.

Explanation:
There was an error creating the help link for the portlet.
User response:

Provide the message output to the IBM Support Center representative.

IRU05035
Help URL is null; cannot append more detailed message.
Explanation:

There was an error while creating the More Details link. The detailed message
cannot be appended to the help file.

User response:

Provide the message output to the IBM Support Center representative.

IRU05036

Context: {0}
Explanation:

There was a problem working with the context.
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User response:

Provide the message output to the IBM Support Center representative.

IRU05037
Error handling: {0}
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05040
Error restarting adapter: {0}
Explanation:
There was an error while reloading a portlet.
User response:

Provide the message output to the IBM Support Center representative.

IRU05041
User ID is null.
Explanation:
There was an error while retrieving the application adapter for the portlet.
User response:

Provide the message output to the IBM Support Center representative.

IRU05042

Error Tlaunching page

Explanation:

A request to launch a missing or nonvalid page was processed.
User response:

Provide the message output to the IBM Support Center representative.
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IRU05043
Error closing page
Explanation:
There was an error while trying to close a page.
User response:

Provide the message output to the IBM Support Center representative.

IRU05044

Error sending message

Explanation:

There was an error while trying to send a queued message request to a portlet.
User response:

Provide the message output to the IBM Support Center representative.

IRU05045
An error occurred while trying to read configuration data.
Explanation:
There was an error while attempting to work with Java preferences.
User response:

Provide the message output to the IBM Support Center representative.

IRU05046

An error occurred while trying to create a component.
Explanation:

An error occurred while trying to create a component.
User response:

Provide the message output to the IBM Support Center representative.

IRU05047

A component with an unknown type was passed: component name = {0};
component type = {1}.
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Explanation:

A component other than a Web server, an application server, or a database is being
used.

User response:

Provide the message output to the IBM Support Center representative.

IRU05049
Attempted to edit with a null key value.
Explanation:
There is a problem with the selected item and it can not be edited.
User response:

Provide the message output to the IBM Support Center representative.

IRU05050
Invalid argument: {0}
Explanation:
An nonvalid argument was passed to a method.
User response:

Provide the message output to the IBM Support Center representative.

IRU05051

Unexpected value, {0}, received for the following object: {1}.
Explanation:

An incorrect trace value was parsed from the console agent properties.
User response:

Check the console agent properties file to ensure the trace value is set properly.

IRU05100

Missing a value for the following key: {0}; cannot execute command.
Explanation:

This message is used only by the IBM Support Center.
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User response:

Provide the message output to the IBM Support Center representative.

IRU05101

The directory name provided ({0}) is not a proper directory.
Explanation:

The Express Console agent can not access the specified remote directory. This
problem occurs most commonly because the console agent has been configured
incorrectly. The task can not be completed.

User response:

Some configuration errors can be corrected by reinstalling the management
extension that is related to the task you are running. For example, if you are
accessing the Servers->HTTP Servers->Details dialog, this error message occurs,
and reinstalling the HTTP management extension might correct the problem. In
other cases, contact the IBM Support Center.

IRU05102

Unable to retrieve contents of the following directory: {0}.
Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.

IRUO5103

InfoCenter

Incorrect password
Explanation:

A valid user ID and password combination are needed for this administration task.
User response:

Use the following table to determine what type of user ID and password
combination is needed:

Table 2.
Management extension Operating system User ID and password type
IBM HTTP Server All windows platforms Any valid operating system

user ID and password with
administration authority
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Table 2. (continued)

Management extension

Operating system

User ID and password type

IBM HTTP Server

All Linux platforms

Any valid operating system
user ID and password with
root authority

IBM HTTP Server

0S/400

Any valid operating system
user ID and password that
has *IOSYSCFG authority

WebSphere Application
Server — Express

All windows platforms

The user ID and password
used to secure the WebSphere
Application Server — Express
server

WebSphere Application
Server — Express

All Linux platforms

The user ID and password
used to secure the WebSphere
Application Server — Express
server

WebSphere Application
Server — Express

0S5/400

Any valid operating system
user ID and password that
has *IOSYSCFG and
*ALLOBJ authority

DB2 UDB Express

All windows platforms

Any valid DB2 admin user
ID and password

DB2 UDB Express

All Linux platforms

Any valid DB2 admin user
ID and password

DB2 UDB Express

0S/400

Any valid operating system
user ID and password that
has DB2 admin authority

IRUO5104

Could not retrieve the correct logger in order to set the trace levels.

Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.

IRU05105

Could not read the Windows registry.

Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.
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IRU05106
Unsupported callback type
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05107

Error retrieving CPU usage.

Explanation:

The console agent has encountered an error while monitoring the CPU usage of
one or more of the Express Runtime software components . The system health
indicator and associated performance graphs are available.

User response:

Provide the message output to the IBM Support Center representative.

IRU05108
Starting the console agent server.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05109

Stopping the Console Agent Server.

Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.

IRUO05110

Remote client {0} has been added to the warning list.
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Explanation:

A remote user tried to access the console agent, but the access failed. This occurs
most commonly because an incorrect user ID or password was given. This error
can also occur if an incomplete or partial request was received.

User response:

Usually this error occurs because a user has forgotten a user ID and password
combination. However, if multiple failed attempts from the same remote user
continue to occur, this could be an attempt to break into the system. If you believe
that there is an attempted breakin, contact your security representative.

IRUO5111

Remote client {0} has been exiled due to too many consecutive warnings. The
client will be unable to access the server for 1 hour.

Explanation:

A remote user has repeatedly failed to enter the correct user ID and password
combination. Most likely, this error occurred because someone is trying to break
into the system by guessing user ID and password pairs. To aid in the prevention
of this hacking technique, the remote user will automatically be locked out of the
system for one hour.

User response:
Take appropriate steps to determine the origin of the erroneous requests. You

should also take necessary steps to protect or shutdown the server until the cause
of erroneous requests can be resolved.

IRU05112

Remote client {0} has accessed the server. The remote client was previously
exiled from the server.

Explanation:

This message can occur after a user has been locked out of the system (exiled) for
some period of time. The original login problem was resolved and the remote user
then logged in with the correct user ID and password. This message can also occur
if the hacking technique of guessing user ID and password pairs is left unchecked
and the hacker eventually guessed the correct user ID and password combination.

User response:

Inspect the security logs on the target system and investigate the cause of the
problem.

IRUO05113

Remote client {0} attempted to access the server. The remote client is
exiled from the server.
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Explanation:

A remote user has repeatedly failed to enter the correct user ID and password
combination. Most likely, this error occurred because someone is trying to hack
into the system by guessing user ID and password pairs. To aid in the prevention
of this hacking technique, the remote user has been automatically locked out of the
system for one hour. Duning the lockout period, the user is continuing to attempt
to access the server but the request is being ignored.

User response:
Take appropriate steps to determine the origin of the erroneous requests. Also take

necessary steps to protect or shutdown the server until the cause of erroneous
requests can be resolved.

IRUO5114

Remote client {0} issued an unknown server command. This command did not
originate from the IBM Express Runtime console.

Explanation:

Erroneous or poorly formatted requests to the console agent are ignored, and most
likely did not originate from the IBM Express Runtime console. Repeated requests
can be a sign of an attempt to hack into the system.

User response:

Take appropriate steps to determine the origin of the erroneous requests.

IRU05115

User {0} on remote client {1} accessed IBM HTTP Server instance {2} by
browsing folder: {3}.

Explanation:
This is an informational message.
User response:

No action is required.

IRU05116

InfoCenter

User {0} on remote client {1} accessed IBM HTTP Server instance {2} by
viewing log file: {3}.

Explanation:
This is an informational message.
User response:

No action is required.



IRUO5117

User {0} on remote client {1} accessed IBM HTTP Server instance {2} by
changing the log settings.

Explanation:
This is an informational message.
User response:

No action is required.

IRUO05118

User {0} on remote client {1} accessed IBM HTTP Server instance {2} by
issuing the command: {3}.

Explanation:
This is an informational message.
User response:

No action is required.

IRU05119

User {0} on remote client {1} accessed IBM HTTP Server instance {2} by
querying the state of the server.

Explanation:
This is an informational message.
User response:

No action is required.

IRU05120

User {0} on remote client {1} accessed WebSphere Application Server
instance {2} by issuing the command: {3}.

Explanation:
This is an informational message.
User response:

No action is required.
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IRUO5121

User {0} on remote client {1} accessed WebSphere Application Server

instance {2} by querying the state of the server.
Explanation:

This is an informational message.

User response:

No action is required.

IRU05122

User {0} on remote client {1} queried tracelLevel settings.
Explanation:

This is an informational message.

User response:

No action is required.

IRU05123

User {0} on remote client {1} set tracelLevel settings.
Explanation:

This is an informational message.

User response:

No action is required.

IRUO05124

InfoCenter

User has been locked out of the system.

Explanation:

A remote user has repeatedly failed to enter the correct user ID and password
combination. Most likely, this error occurred because someone is trying to hack
into the system by guessing user ID and password pairs. To aid in the prevention
of this hacking technique, the remote user will automatically be locked out of the

system for one hour.

User response:

Take appropriate steps to determine the origin of the erroneous requests. You
should also take necessary steps to protect or shutdown the server until the cause

of erroneous requests can be resolved.



IRU05125

Could not find server instance.

Explanation:

The instance of the IBM HTTP Server that you are attempting to administer cannot
be found. Most likely this error occurred due to an incorrect console agent
configuration or an incorrect installation of the IBM HTTP Server.

User response:

If the problem persists, reinstall the HTTP management extension, or reinstall the
IBM HTTP Server. If the problem persists, contact the IBM Support Center.

IRU05126

Invalid Port: {0}

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05127

Could not find the Apache service name for configuration file {0}.
Explanation:

The console agent can only start and stop instances of IBM HTTP Server that are
configured as a Windows service. There was not a Windows service entry
corresponding to the requested IBM HTTP Server instance.

User response:

Configure the IBM HTTP Server instance to be a Windows Service. See IBM HTTP
Server documentation.

IRU05128
IBM HTTP Server instance {0} could not be found.
Explanation:
The instance of the IBM HTTP Server you are attempting to administer cannot be

found. Most likely this error occurred due to an incorrect console agent
configuration or an incorrect installation of the IBM HTTP Server.
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User response:

You might need to reinstall the HTTP management extension, or reinstall the IBM
HTTP Server. If the problem persists, contact the IBM Support Center.

IRU05129

The page you requested is not supported.
Explanation:

The console agent does not support the request made by the Express Runtime
console.

User response:

No action is required; the function is not supported by this operating system.

IRU05130

The specified WebSphere Application Server port ({0}) could not be found.
Explanation:

To administer the WebSphere Application Server, the administrative console port
must be specified. The default port is 9080, but can be changed during installation.

User response:

Ensure that the port number that was entered corresponds to the administrative
console port. To change the port click Add / remove servers. Select the server
name from the server list and click Edit. Type in the new administrative console
port number and click Apply. You can test the new value by clicking Test
connection.

IRU05131

The console agent is not configured to manage WebSphere Application
Servers.

Explanation:

The console agent is not configured to manage WebSphere Application Server —
Express servers.

User response:
If WebSphere Application Server — Express is installed on this system and you

want to manage the system, install the WebSphere Application Server — Express
management extensions.

IRU05132

The console agent is not configured to manage IBM HTTP Server instances.
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Explanation:
The console agent is not configured to manage IBM HTTP Server instances.
User response:

If the IBM HTTP Server is installed on this system and you want to manage the
server, install the IBM HTTP Server management extensions.

IRU05140

New server Tistener created: server IP address={0} server port={1}.

Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.
IRU05141

Cannot find file: {0}.

Explanation:

This is an informational message.

User response:

No action is required.

IRU05142

Added new command: {0}.
Explanation:

This is an informational message.
User response:

No action is required.

IRU05143

Entered the ServiceMain() method.
Explanation:

This is an informational message.
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User response:

No action is required.

IRU05144
Start server control signal detected.
Explanation:
This is an informational message.
User response:

No action is required.

IRU05145
Server started successfully.
Explanation:
This is an informational message.
User response:

No action is required.

IRU05146
Server is shutting down.
Explanation:
This is an informational message.
User response:

No action is required.

IRU05147

Server did not start successfully.
Explanation:

This is an informational message.
User response:

No action is required.
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IRU05148
Stop server control signal detected.
Explanation:
This is an informational message.
User response:

No action is required.

IRU05149

Checking server PID: exists={0}.
Explanation:

This is an informational message.
User response:

No action is required.

IRU05150
Server listener stopped.
Explanation:
This is an informational message.
User response:

No action is required.

IRU05151

New remote connection detected and created. Starting new thread for
connection.

Explanation:
This is an informational message.
User response:

No action is required.

IRU05152

Request body: <start>{0}<end>
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Explanation:
This is an informational message.
User response:

No action is required.

IRUO05153
Response body: <start>{0}<end>
Explanation:
This is an informational message.
User response:

No action is required.

IRUO05154

Request header: <start>{0}<end>
Explanation:

This is an informational message.
User response:

No action is required.

IRU05155
Request header key={0} value={1}
Explanation:
This is an informational message.
User response:

No action is required.

IRU05156
Response header: <start>{0}<end>
Explanation:
This is an informational message.
User response:

No action is required.
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IRU05157
Found command in request URI: {0}.
Explanation:
This is an informational message.
User response:

No action is required.

IRUO05158
Found keys in request: {0}.
Explanation:
This is an informational message.
User response:

No action is required.

IRU05159

Starting execution of command: {0}.
Explanation:
This is an informational message.
User response:
No action is required.

IRU05160
Type of 0S: {0}
Explanation:
This is an informational message.
User response:

No action is required.

IRUO5161

Mapping virtual name: {0} to configuration file: {1}.
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Explanation:
This is an informational message.
User response:

No action is required.

IRU05162

Loading configuration file: {0}.
Explanation:

This is an informational message.
User response:

No action is required.

IRU05163

No server instance found. Setting to default instance:

Explanation:
This is an informational message.
User response:

No action is required.

IRUO05164

Cookies for execute command: {0}
Explanation:

This is an informational message.
User response:

No action is required.

IRUO05165

InfoCenter

Keys for execute command: {0}
Explanation:

This is an informational message.
User response:

No action is required.

{0}.



IRU05166
Found serivceName mapping for configuration file: {0} to service: {1}.
Explanation:
This is an informational message.
User response:

No action is required.

IRU05167
About to execute command: <start>{0}<end>.
Explanation:
This is an informational message.
User response:
No action is required.

IRU05168
Output of command: <start>{0}<end>
Explanation:
This is an informational message.
User response:

No action is required.

IRU05169

Found HTTP Service for serviceName: {0}.
Explanation:

This is an informational message.

User response:

No action is required.

IRU05170

Arguments for the service are: {0}.
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Explanation:
This is an informational message.
User response:

No action is required.

IRU05171
Adding service mapping for confFile: {0} to serviceName {1}.
Explanation:

This is an informational message.
User response:

No action is required.

IRU05172

Looking for process ID for server instance: {0} at {1}.
Explanation:

This is an informational message.

User response:

No action is required.

IRU05173
Looking for log file at {0}.
Explanation:
This is an informational message.
User response:

No action is required.

IRU05174
Verifying log file {0}.
Explanation:
This is an informational message.
User response:

No action is required.
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IRUO05175
Client locale: {0}
Explanation:
This is an informational message.
User response:

No action is required.

IRU05176

User is set to: {0}.
Explanation:

This is an informational message.
User response:

No action is required.

IRU05177
No persistent agents declared.
Explanation:
This is an informational message.
User response:
No action is required.
IRUO05178
Stopping persistent agent: {0}.
Explanation:
This is an informational message.
User response:

No action is required.

IRU05179

Configuration file {0} failed verification. It will not be added to the
list of available servers.
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Explanation:
This is an informational message.
User response:

No action is required.

IRU05180
Server Started on {0}, port: {1}.
Explanation:
This is an informational message.
User response:

No action is required.

IRU05181

Pluggable authentication module error: {0}
Explanation:

This is an informational message.

User response:

No action is required.

IRU05182
Error while decoding URL: {0}.
Explanation:
This is an informational message.
User response:

No action is required.

IRU05183
Unable to keep up with polling interval: {0} ms.
Explanation:
This is an informational message.
User response:

No action is required.
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IRUO05184
Invalid process ID: {0}
Explanation:
This is an informational message.
User response:

No action is required.

IRU05185

Error getting children for process ID: {0}.
Explanation:

This is an informational message.

User response:

No action is required.

IRU05200

Server data entered is not incorrect: server= {0} port={1} agent port={2}.
Explanation:

You entered incorrect data for either the WebSphere Application Server — Express
server host name, the WebSphere Application Server — Express console port, or the
console agent port, while trying to configure the server.

User response:

The user should verify the data entered in the Add/remove portlet is correct. The
fields should not be left blank.

IRU05201

Could not find portlet instance data; returning default URL: portlet
instance ID:{0} user ID:{1} user key: {2}.

Explanation:

The necessary information needed to build the URL for the Websphere Application
Systems console task is missing. The default URL will be used.

User response:

Provide the message output to your service representative.
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IRU05202
No task was defined; using a default URL.
Explanation:

The specific Websphere Application Server console task data is not defined. The
task URL cannot be built without the data; the default URL is being used.

User response:

Provide the message output to the IBM Support Center representative.

IRU05203
The current user is already in the hash table.
Explanation:
This is an informational message.
User response:
No action is required.
IRU05204
The current user is not in the hash table; creating a new one.
Explanation:
This is an informational message.
User response:

No action is required.

IRU05205

No portal user defined; cannot continue.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05206

Unable to log out from server {0}.
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Explanation:

The logout request to the specified Websphere Application Server was not
successful. There is chance that user was not completely logged out of the server.
The user may have a login conflict on the next login to the server.

User response:

Check the error logs and the trouble shooting section for more details. Provide the
message output to the IBM Support Center representative.

IRU05207

Could Tog out since an exception ocurred: {0}. The URL for logout was {1}.
Explanation:

The logout request to the Websphere Application Server server threw an exception.
There is chance that user was not completely logged out of the server. The user
may have a login conflict on the next login to the server.

User response:

Check the error logs and the trouble shooting section for more details. Provide the
message output to the IBM Support Center representative.

IRU05208

User key is null; could not log out.

Explanation:

The necessary user information needed for the logout request for a Websphere
Application Server is missing. The user was not logged out of the server. The user
may have a login conflict on the next login to the server.

User response:

Check the error logs and the trouble shooting section for more details. Provide the
message output to the IBM Support Center representative.

IRU05209

Server is null; did not attempt to log out.

Explanation:

The necessary server information needed for the logout request for a Websphere
Application Server is missing. The user was not logged out of the server. The user
may have a login conflict on the next login to the server.

User response:

Check the error logs and the trouble shooting section for more details. Provide the
message output to the IBM Support Center representative.
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IRU05210

Could not Tog out since user {0} does not exist in Tist.

Explanation:

The Express Runtime console’s Websphere Application Server management
extension could not log out the specified user, since the user was not found in the
list. The user may have a login conflict on the next login to the server.

User response:

Check the error logs and the troubleshooting section for more details. Provide the
message output to the IBM Support Center representative.

IRUO05211

Could not Tog out since userkey was missing.

Explanation:

The Express Runtime console’s Websphere Application Server management
extension could not log out the user, since the data needed to determine the user is
missing. The user may have a login conflict on the next login to the server.

User response:

Check the error logs and the trouble shooting section for more details. Provide the
message output to the IBM Support Center representative.

IRU05212
Exception occurred while cleaning out workspace.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05213
Could not connect to server, since the port provided is not a HTTP port.
Explanation:
The connection to the server could not be established, since the Websphere

Application Server administrative port provided is not a valid HTTP port. Most
likely the port provided is the HTTPS port.
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User response:
Ensure that the administrative port provided is a valid HTTP port. If it is not,

modify the configuration for the server. Check the troubleshooting section for more
details, including how to determine the administrative HTTP port.

IRU05214

Could not connect to server because of unexpected return code: {0}.
Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.

IRU05215

Exception occured during redirect. The message is: {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05216

Could not determine the version of WebSphere Application Server for the
following server: {0}. Version information is {1}.

Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05217

Error with WebSphere Application Server version, {0}; thus cannot log out
of the WebSphere Application Server, {1}.

Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.
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IRU05218

No version information was provided.
Explanation:

You must provide version information.
User response:

Provide version information.

IRU05219

The version, {0}, entered is not supported.
Explanation:

The provided version is not supported.

User response:

Provide a supported version.

IRU05230

Server={0}, port={1}

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05231

The Tist of visited servers is: {0}. The list size is {1}.
Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.

IRU05232

InfoCenter

The active state is {0}.



Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05233

The parameter list from the portlet XML is {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05234

Trying to Tog out from server {0}, using this URL: {1}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05235
Adding a close request for the following page: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05236
Does the user need to be prompted for a profile conflict: {0}?
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.
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IRU05237
Do we have a profile conflict: {0}?
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05238
Was the instance removed sucessfully: {0}?
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05239

Trying to remove the following instance: {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05240

The parameter list, after parsing, is: {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05241

The current user is already in the hash table.

116 InfoCenter



Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05242

The current user is not in the hash table; creating a new one.
Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.

IRU05243

The WebSphere Application Server console task ID is: {0}.
Explanation:

This is an informational message.

User response:

No action is required.

IRU05260
The referrer value from {1} is {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05261
The session ID is {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.
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IRU05262
The request URL is {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05263
Name={0}, value={1}
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05264
Information in the task data is: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05265

The session is already invalidated; cannot Tog out. The following exception
occured: {0}.

Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05266

The action command is: {0}.

118 InfoCenter



Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05267

The Togin action was successful.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05268

The action going forward is: {0}.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05269
Treating request as a new task Taunched from Integrated Solutions Console.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05270

The redirect URL is the new value with WebSphere Application Server
parameters: {0}.

Explanation:

This message is used only by the IBM Support Center.
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User response:

Provide the message output to the IBM Support Center representative.

IRU05271

Found existing key {0}, with value: {1}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05272

Treating request as a refresh from Integrated Solutions Console.
Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.

IRU05273

The user mapped to session list is: {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05274

InfoCenter

The application server user from session is: {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.



IRU05275
The workspace is: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05276
Changes not found; clearing workspace.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05277

Changes found; not clearing workspace.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05278

No matches found in the hash table to track portlets.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05279

The referrer matches with a value in the hash; the matching key is {0}.
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05280
The stored task data for the key, {0}, is: {1}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05281

Treating request as normal processing and continuing to save the drill-down
information.

Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05282

Treating request as a redirect URL.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05283

The unigue portlet key/ID is {0}.
Explanation:

This message is used only by the IBM Support Center.

122  InfoCenter



User response:

Provide the message output to the IBM Support Center representative.

IRU05284
The full URL to store is {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05285
The session is not associated with Integrated Solutions Console.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05286
Adding user key {0} to the user mapped to session list.
Explanation:
This message is used only by the IBM Support Center.
User response:
Provide the message output to the IBM Support Center representative.
IRU05287
The value of the previous task key is: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.
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IRU05288
Starting filter {0} processing.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05289
Finishing filter {0} processing.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05290

The session has been invalidated.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05291

The state of the session according to the server is: {0}.
Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.

IRU05292

The session ID to state Tist is: {0}.
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05300
Base administration page is {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05301

Error in processing the DOM: {0}

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05302
Node name: {0}
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05303
In prompt user - Panel={0} UTM={1}
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.
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IRU05305

The SSL certificate dialog is about to be displayed to the user. The dialog
will be nonmodal.

Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05306

The SSL certificate dialog has been displayed to the user. The dialog is
nonmodal .

Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05307

The SSL certificate dialog is about to be displayed to the user. The dialog
will be modal.

Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05308

InfoCenter

The SSL certificate dialog has been displayed to the user. The dialog was
modal.

Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.



IRU05309
SSL certificate was accepted.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05310
SSL certificate was not accepted.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRUO05311

The command is null.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05312

The following command is {0}.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05313

There are no error messages to display.
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05314
Displaying the following messages: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05315

There are no items to remove.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05316
The number of items to remove is {0}. The items are {1}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05317
Removing context from hash, since the selected context was set to null.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.
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IRU05318
Sending message with the following context: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05319
Retrieving the following context for the hash: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:
Provide the message output to the IBM Support Center representative.
IRU05320
The URL is {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05321

Did not find the Tast selected context; looking for a persistent context.
Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.

IRU05322

Found the following persistent context: {0}.
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05323

The help URL is {0}.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05324

Returning since no change found in context list.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05325

Could not find context in Tlist.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05326

InfoCenter

Context is null or empty.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.



IRU05327
TrustManager={0} Size={1}
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05328

Received an Integrated Solutions Console save context action. Saving the
context.

Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05329
Sending the context as the message.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05330

The action was handled by sendContextAsMessage. It is returning without
calling super.actionPerformed.

Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05332

Object {0} has a null value.
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05333

The action {0} is being passed to the superclass for handling.
Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.

IRU05334

Key={0} Value={1}

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05335

The read line is: {0}.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05336

InfoCenter

Adding cookie: key={0}, value={1}.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.



IRU05337
String buffer is: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05338
Setting cookies [{0}].
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05339
Opening connection: sUrl1={0}.
Explanation:
This message is used only by the IBM Support Center.
User response:
Provide the message output to the IBM Support Center representative.
IRU05340
Working with key {0} value {1} pair.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05341

Did not find a message; returning false.
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05342
Removing the message from context.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05343

Returning since persistedContext = {0} or userName = {1}.
Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.

IRU05344

Object {0} is either null, empty, has a size of 0, or has nothing Teft to
iterate through.

Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05345

Sending the new context to {0}.
Explanation:

This message is used only by the IBM Support Center.
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User response:

Provide the message output to the IBM Support Center representative.

IRU05346
Creating credentials with session ID(uo) {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05347
Found user ID {0} for resource {1}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05348
Deleting the credentials for the following resource: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:
Provide the message output to the IBM Support Center representative.
IRU05349
Creating the following credential slot ID: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.
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IRU05350
Updating the following credential slot id: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05351
Retrieving the credentials with resource {0} and session ID {1}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05352

Attempting to start a server.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05353

Attempting to stop a server.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05354

IBM Express Runtime, Version {0} build:{1} component:{2}
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05355

Attempting to use multi-threaded certificate check.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05356

UserTaskManager is null or could not be found.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05357
Starting isAlive() for: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05358
The result for isAlive() is: {0} = {1}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.
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IRU05406
The selected IBM HTTP Server instance is : {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05407
The IBM HTTP Server instance list is null.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05408

New node created with ID: {0} and display name: {1}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05409

The selected tree node is: {0}.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05410

The status for IBM HTTP Server {0} is {1}.
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05411

The console agent URL is : {0}.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05412
The process ID value of the IBM HTTP Server being administered is: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05413

The fully qualified PID value of IBM HTTP Server being administered is:
{0}.

Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRUO05414

The log settings level is: {0}.
Explanation:

This message is used only by the IBM Support Center.
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User response:

Provide the message output to the IBM Support Center representative.

IRU05415

The host name Tookup status is: {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05416

The cookie status tracking is : {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05417

The root node is: {0}.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05418

InfoCenter

The node is : {0}.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.



IRU05419
The string to be parsed is : {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05420
The node value is : {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:
Provide the message output to the IBM Support Center representative.
IRU05421
Attributes: [ {0} ]
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05422

The children of the node are {0}.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05500

Error parsing the return for the agent, {0}.
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Explanation:
This message is displayed when a port number cannot be resolved into an integer.
User response:

Verify the agent installation.

IRU05501
Specify a host name.
Explanation:
Provide a fully-qualified host name.
User response:

Provide a fully-qualified host name.

IRU05502

Failed: Select a host name before clicking Edit.

Explanation:

A host name must be selected before you can edit the properties of the host.
User response:

Select a host name.

IRU05503
Failed: Select only one host name before clicking Edit.
Explanation:
You can only select one host name at a time to edit.
User response:

Select only one host name at a time when editing host properties.

IRU05504
Failed: Select at least one host name.
Explanation:
You must select at least one host name to continue with the task.
User response:

Select a host name.
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IRU05505
Failed: Provide user ID and password for the host name, {0}.
Explanation:
You must provide a user ID and a password to authenticate with a host.
User response:

Provide a user ID and password.

IRU05506

An error has occurred while determining the status of the following
component, {0}.

Explanation:
The status of a component cannot be determined.
User response:

This is an informational message. No user action is required.

IRU05507
Select at least one custom solution from the table.
Explanation:
You must select at least one custom solution to complete the task.
User response:

Select at least one custom solution.

IRU05508

No components/custom solutions located on the following host name, {0}.
Explanation:

No components or custom solutions have been located on the host.

User response:

This is an informational message. No user action is required.

IRU05509

The certificate verification for the following host name, {0}, at agent
port, {1}, failed.
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Explanation:
The certificate was not accepted by the user or the host.
User response:

Ensure that you have an updated certificate, or that you accept a certificate when
authenticating with a host.

IRU05510

Could not connect to the following host name, {0}.
Explanation:

A connection with the host cannot occur.

User response:

Ensure that the host name and that the console agent port is correct. Also ensure
that the console agent is installed and running.

IRUO05511

The requested function is not available for the following host name, {0}.
Explanation:

You cannot perform this task using the selected resource.

User response:

You must upgrade the version of the console agent.

IRU05512

Failed: incorrect user ID or password on the following host name, {0}.
Explanation:

The user ID and password provided are incorrect.

User response:

Ensure that you provide the correct user ID and password.

IRU05513

InfoCenter

Failed: The user is locked out on the following host name, {0}.
Explanation:

An attempt was made to log in to the console agent too many times. As a security
measure, the agent has locked the user out for a specified amount of time.



User response:

Contact the system administrator.

IRU05514
Unable to determine status. Check the console logs.
Explanation:
The console cannot determine the status of a component or custom solution.
User response:

This is an informational message. No user action is required.

IRU05515
Unknown component type.
Explanation:
The component type on the host is not known or recognized.
User response:

This is an informational message. No user action is required.

IRU05525

Error while parsing custom solution XML file, {0}. Check console agent Tlogs
on {1} for details.

Explanation:
An error occurred parsing the XML file.
User response:

View the console agent log for more information.

IRU05526

The HTTP Server instance, {0}, referenced in the custom solution XML, {1},
is not configured.

Explanation:
The agent cannot locate the specific HTTP Server instance.
User response:

Ensure that the HTTP Server instance is configured.
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IRU05527
Unable to parse the HTTP Server instance from the custom solution XML, {0}.
Explanation:
The XML cannot be parsed for the HTTP Server.
User response:

Ensure that the XML is formatted and formed correctly.

IRU05528

The WebSphere Application Server profile, {0}, referenced in the custom
solution XML, {1}, is not configured.

Explanation:
The agent cannot locate the specific WebSphere Application Server instance.
User response:

Ensure that the WebSphere Application Server instance is configured.

IRU05529

Unable to parse the WebSphere Application Server profile from the custom
solution XML, {0}.

Explanation:
The XML cannot be parsed for the WebSphere Application Server.
User response:

Ensure that the XML is formatted and formed correctly.

IRU05530

Could not find the translated text for the following key, {0}, from the
custom solution XML, {1}.

Explanation:
A translated value cannot be located in a properties file.
User response:

Ensure that translated text is located in a properties file for all possible values.

IRU05531

An 10 exception occurred while reading the custom solution XML file on {0}.
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Explanation:
The XML is not formatted or formed correctly.
User response:

Ensure that the XML is formatted and formed correctly.

IRU05532
A parse exception occurred while reading the custom solution XML file on
{0}.

Explanation:

The XML is not formatted or formed correctly.

User response:

Ensure that the XML is formatted and formed correctly.

IRU05533

A SAX exception occurred while reading the custom solution XML file on {0}.
Explanation:

The XML is not formatted or formed correctly.

User response:

Ensure that the XML is formatted and formed correctly.

IRU05534

The customSolutions folder is missing on {0}. The path being used for the
folder is {1}.

Explanation:
The folder where the console agent expects to find XML files is missing.
User response:

Ensure that the customSolutions folder exists.

IRU05535

Error adding the profile {0} to the node on {1}.
Explanation:

No information can be discovered about the specified component.
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User response:

This is an informational message. No user action is required.

IRU05536

The RAC port is missing from the properties file on {0}.
Explanation:

The properties file requires the RAC port to be provided.
User response:

Provide a RAC port number.

IRU05537

The context provided {0} is not valid for {1}.

Explanation:

The information sent to the agent from the client cannot be identified.
User response:

This is an informational message. No user action is required.

IRU05800

Error getting dispatcher or service request.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05801

InfoCenter

Null value found for asyncBackup.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.



IRU05802
Null value found for resultsUtm.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05803

Authentication failed for {0}.

Explanation:

This message indicates that there was a failure in authentication.

User response:

Ensure that the correct authentication credentials are entered and try again.
IRU05804

Login attempt to {0} by {1}.

Explanation:

This message contains security audit information.

User response:

No action is required.

IRU05805

Get database 1ist for server {0}; the instance is {1}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05806

Could not retrieve the 1ist of databases.
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05807

AppAdapter or UTM is null; cannot refresh.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05808

Method getDirectory - getDirectorylList failed.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05809

Method getName returned null for {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05810

InfoCenter

Error parsing time {0}.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.



IRU05811
Failed to Toad JDBC driver.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05812
JDBC connection requires valid database remote name: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05813

JDBC connection URL:

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05814

JDBC driver metadata:

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRUO5815

Failed to establish JDBC connection: {0}.
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05816

JDBC connection was closed successfuly.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05817

Failed to close JDBC connection.

Explanation:

This message contains information for use by service.
User response:

Provide the message output to your service representative.

IRU05818

Failed to retrieve AdminClient: {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05819

InfoCenter

Failed to invoke MBean: {0}.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.



IRU05820
Failed to find MBean: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05821
Failed to retrieve user message for SQL code: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:
Provide the message output to the IBM Support Center representative.
IRU05822
DASFileSystemService failed during the DAS API call: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05823

Catalog

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05824

Database catalog requires a valid context file: {0}.
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05825

Current catalog entries: {0}

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05826

Database key not found: {0}.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05827

DB2Alert requires valid arguments: ID, timestamp.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05828

InfoCenter

Failed JDBC call: {0}

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.



IRU05829
Failed to recover DB2 port: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05830

DB2Database requires valid arguments: alias, name, host name, instanceName,
db2portNumber, jmxPortNumber, and version.

Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRUO05831

DB2Database requires valid DB2 port: {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05832

DB2Database requires valid argument: jmxPortNumber: {0}.
Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.

IRU05833

Failed DAS execution SQL code check: {0}.
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05834

Instance db2start command failed and returned {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05835

Instance db2start command succeeded and returned {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05836

Instance db2stop command failed and returned {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05837

InfoCenter

Instance db2stop command succeeded and returned {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.



IRU05838
Instance ATTACH command failed and returned {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05839
Instance ATTACH command succeeded and returned {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05840

Database not available due to: {0}.

Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.
IRU05841

Implemented in the connector through a call to TableUDF: SNAPSHOT_DATABASE.

Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.

IRU05842

Database backup requires valid: instanceName, dbName, userID, passwd, path.
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05843

Failed to set up success code sets: {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05844

DAS execution failed and backup script returned {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05845

Database backup command failed and returned {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05846

InfoCenter

Database backup succeeded and returned {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.



IRU05847
Admin command failed and returned {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05848
Admin command failed unexpectedly: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05849

Asynchronous command to be executed in less than {0} seconds.
Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.

IRU05850

Command execution did not finish after {0} seconds.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05851

Command execution failed.
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05852
Command execution failed unexpectedly.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05853

Failed to retrieve DATABASES from DB2 Server: [{0}] with error code: [{1}]
due to SQL error: [{2}].

Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05854

Failed to retrieve database configuration: {0}.

Explanation:

This message is used only by the IBM Support Center.

User response:

Provide the message output to the IBM Support Center representative.
IRU05855

Retrieved [{0}] from [{1}] discovered databases on host: [{2}].

Explanation:

This message is used only by the IBM Support Center.
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User response:

Provide the message output to the IBM Support Center representative.

IRU05856

Failed to retrieve databases for TCPIP node: [{0}] from DB2 Server: [{1}]
with error code: {2}] - SQL error: [{3}].

Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05857
DB2 node found: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05858
Stored procedure call: {0}
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05859
SQLCAMessage SP execution failed with error code {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.
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IRU05860

Failed to retrieve error message.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRUO05861

Failed during the SP call: {0}.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05862

DB2 udfStmt: {0}

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05863

Failed during the UDF call: {0}.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05864

InfoCenter

Retrieved: {0}.



Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05865
Failed to build query: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05866

Failed to query MBeanServer: {0}.

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05867
Failed to find MBeanServer for: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05868
Failed to contact JMX on port {0}: {1}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.
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IRU05869
Failed to contact JMX on port {0}/{1}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05870
Instance (node) state: {0}
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05871

DB2 management services initialization
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05872

Retrieve DB2 Services configuration file.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05873

Failed to load configuration file: [{0}] due to: {1}.
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05874
Failed to access configuration file [{0}] due to: {1}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05875
Erroneous DB2 services configuration: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05876
Logger configuration type: {0}
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05877
Initialized DB2 common trace: [{0}].
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.
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IRU05878
Failed to open/write trace file: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05879
Failed to initialize DB2 common trace: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05880

Asynchronous execution response delay: {0} seconds
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05881

DB2 management services registered: {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05882

Failed to register [{0}] due to: {1}.
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05883

Attempting to load [db2srvapi] shared library.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05884

Failed to Toad [db2srvapi] shared library: {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05885
Successfuly Toaded [db2srvapi] shared Tibrary.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05886
Error code is expected to be an integer: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.
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IRU05887
DB2ServiceDispatcher requires a valid context: {0}.
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05888
Found in catalog database: {0}
Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05889

User response: {0}

Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05890

Failed to retrieve platform; unsupported type: {0}.
Explanation:

This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05891

DB2Database requires valid arguments: locale, dbAlias, userID, passwd.
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Explanation:
This message is used only by the IBM Support Center.
User response:

Provide the message output to the IBM Support Center representative.

IRU05900

User ID={0}, remote host name={1}, action=initialize portlet {2}
Explanation:

This is a security audit log message. It occurs when a portlet is loaded.
User response:

No action is required.

IRU05901

User ID={0}, action=close portlet {1}

Explanation:

This is a security audit log message. It occurs when a portlet is closed.
User response:

No action is required.

IRU05903

Integrated Solutions Console user {0} failed to log on to server {1} using
the Web server user ID {2}.

Explanation:

This is a security audit log message. It occurs when a user in the Integrated
Solutions Console attempted to administer a Web server with invalid credentials.

User response:

No action is required.

IRU05904

Integrated Solutions Console user {0} has changed configuration on Web
server {1} using Web user ID {2}.

Explanation:

This is a security audit log message. It occurs when the configuration for a Web
server is changed.
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User response:

No action is required.

IRU05907

Integrated Solutions Console user {0} failed to log in to server {1} with
console agent user ID {2}.

Explanation:

This is a security audit log message. It occurs when a user tries to connect to the
console agent to work with configuration settings with invalid credentials.

User response:

No action is required.

IRU05908

User {0} has issued a {1} command on {2}: {3}.
Explanation:

This is a security audit log message. It occurs when a user starts or stops a DB2
database.

User response:

No action is required.

IRU05909

User {0} has issued a Backup command on {1}: {2}.
Explanation:

This is a security audit log message. It occurs when a user issues the backup
command for a DB2 database.

User response:

No action is required.

Trademarks
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InfoCenter

The following terms are trademarks of the IBM Corporation in the United States,
other countries or both:

+ IBM

« 05/400

+ i5/0S

+ DB2

* WebSphere



Java, and all Java-based trademarks and logos and Solaris are trademarks or
registered trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Microsoft and Windows and Windows NT® are registered trademarks of Microsoft
Corporation in the United States, other countries, or both.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries or both.

UNIX® is a registered trademark of The Open Group.

Intel and Pentium are registered trademarks of Intel Corporation in the United
States, other countries, or both.

Other company, product, and service names may be trademarks or service marks
of others.
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Chapter 6. Accessibility

Accessibility and keyboard shortcuts

You can use screen-reader software to hear what is displayed on the user interface
of the deployment wizard. You can operate all features using the keyboard instead
of the mouse. Express Runtime honors system accessibility settings, such as font
and color settings. Accelerator and mnemonic keys are enabled throughout Express
Runtime console.

You can use keys or key combinations to perform operations that can also be done
through mouse actions. Refer to the help for your browser for more guidance.
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Chapter 7. Related information

Documentation for contained products

IBM Express Runtime

Installed on your system:

* Windows: Start > Programs > IBM Express Runtime 2.1 > Documentation >
Express Runtime Documentation

* RedHat Linux 8.0: Extras > Other > IBM Express Runtime 2.1 > Documentation
> Express Runtime Documentation

* SUSE Linux 8.1: Start > Programs > IBM Express Runtime 2.1 > Documentation
> Express Runtime Documentation

DB2 UDB Express

On the Web: |http:/ /www.ibm.com /software/data/db2/udb/| (for iSeries:
lhttp: / /www.ibm.com/servers/eserver/iseries/db2 /)

After DB2 Express is installed you can access its documentation through menu
shortcuts:

* Windows: Start > Programs > IBM DB2 > Information > Information Center

¢ RedHat Linux 8.0: Extras > Other > IBM DB2 > Information > Information
Center

* SUSE Linux 8.1: Start > Programs > IBM DB2 > Information > Information
Center

Informix Dynamic Server Express

On the Web: |http:/ /publib.boulder.ibm.com /infocenter/ids9help /index.jsp|

After Informix Dynamic Server Express is installed you can access its
documentation through menu shortcuts:

* Windows: Start > Programs > Informix Dynamic Server Express 10.0 >
Documentation Notes

* SUSE Linux 8.1: Start > Programs > Informix Dynamic Server Express 10.0 >
Documentation Notes

IBM HTTP Server

On the Web: |http:/ /www.ibm.com /software/webservers /httpservers/ | (for iSeries:
lhttp:/ /www.ibm.com/servers/eserver/iseries /software /http /)

After IBM HTTP Server is installed you can access its documentation through
menu shortcuts:

* Windows: Start > Programs > IBM HTTP Server > Documentation
* RedHat Linux 8.0: Extras > Other > IBM HTTP Server > Documentation
* SUSE Linux 8.1: Start > Programs > IBM HTTP Server > Documentation
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WebSphere Application Server - Express

On the Web: |http:/ /www.ibm.com /software/webservers/appserv/express/| (for
iSeries: |http:/ /www.ibm.com /servers/eserver /iseries/software/websphere /)

When WebSphere Application Server Express is installed you can access its
documentation through menu shortcuts:

* Windows: Start > Programs > IBM WebSphere Application Server - Express 5.1 >
FirstSteps, Readme, Getting Started

* RedHat Linux 8.0: Extras > Other > IBM WebSphere Application Server -
Express 5.1 > FirstSteps, Readme, Getting Started

* SUSE Linux 8.1: Start > Programs > IBM WebSphere Application Server -
Express 5.1 > FirstSteps, Readme, Getting Started

JACL: A TCL implementation in Java

On the Web:
lhttp:/ /www.usenix.org /publications/library /proceedings /tcl97 / full papers/lam/lam.pdf]

Integrated Solutions Console

After the Integrated Solutions Console (ISC) is installed you can access its
documentation through the user interface:

* Windows: Log on to ISC. Click the help icon at the top right corner of the
screen.

* RedHat Linux 8.0: Log on to ISC. Click the help icon at the top right corner of
the screen.

* SUSE Linux 8.1: Log on to ISC. Click the help icon at the top right corner of the
screen.
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Appendix. Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

Software Interoperability Coordinator, Department 49XA
3605 Highway 52 N

Rochester, MN 55901

US.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.
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